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Safety Rules and Operating Procedures
1. Note the location of the Emergency Disconnect (red button near the door) to shut off power
in an emergency. Note the location of the nearest telephone (map on bulletin board).
2. Students are allowed in the laboratory only when the instructor is present.
3. Open drinks and food are not allowed near the lab benches.
4. Report any broken equipment or defective parts to the lab instructor. Do not open, remove
the cover, or attempt to repair any equipment.
5. When the lab exercise is over, all instruments, except computers, must be turned off.
Return substitution boxes to the designated location. Your lab grade will be affected if your
laboratory station is not tidy when you leave.
6. University property must not be taken from the laboratory.
7. Do not move instruments from one lab station to another lab station.
8. Do not tamper with or remove security straps, locks, or other security devices. Do not disable
or attempt to defeat the security camera.
9. When touching the FPGA development boards please do not touch the solid-state parts on the
board but handle the board from its edge.
10. ANYONE VIOLATING ANY RULES OR REGULATIONS MAY BE DENIED
ACCESS TO THESE FACILITIES.

I have read and understand these rules and procedures. I agree to abide by these rules and
procedures at all times while using these facilities. I understand that failure to follow these rules
and procedures will result in my immediate dismissal from the laboratory and additional
disciplinary action may be taken.

Signature

Date

Lab #
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Laboratory Safety Information
Introduction
The danger of injury or death from electrical shock, fire, or explosion is present while
conducting experiments in this laboratory. To work safely, it is important that you understand the
prudent practices necessary to minimize the risks and what to do if there is an accident.
Electrical Shock
Avoid contact with conductors in energized electrical circuits. The typical can not let-go (the
current in which a person can not let go) current is about 6-30 ma (OSHA). Muscle contractions
can prevent the person from moving away the energized circuit. Possible death can occur as low
50 ma. For a person that is wet the body resistance can be as low as 1000 ohms. A voltage of 50
volts can result in death.
Do not touch someone who is being shocked while still in contact with the electrical conductor
or you may also be electrocuted. Instead, press the Emergency Disconnect (red button located
near the door to the laboratory). This shuts off all power, except the lights.
Make sure your hands are dry. The resistance of dry, unbroken skin is relatively high and thus
reduces the risk of shock. Skin that is broken, wet, or damp with sweat has a low resistance.
When working with an energized circuit, work with only your right hand, keeping your left hand
away from all conductive material. This reduces the likelihood of an accident that results in
current passing through your heart.
Be cautious of rings, watches, and necklaces. Skin beneath a ring or watch is damp, lowering the
skin resistance. Shoes covering the feet are much safer than sandals.
If the victim isn’t breathing, find someone certified in CPR. Be quick! Some of the staff in the
Department Office are certified in CPR. If the victim is unconscious or needs an ambulance,
contact the Department Office for help or call 911. If able, the victim should go to the Student
Health Services for examination and treatment.
Fire
Transistors and other components can become extremely hot and cause severe burns if touched.
If resistors or other components on your proto-board catch fire, turn off the power supply and
notify the instructor. If electronic instruments catch fire, press the Emergency Disconnect (red
button). These small electrical fires extinguish quickly after the power is shut off. Avoid using
fire extinguishers on electronic instruments.
First Aid
A first aid kit is located on the wall near the door. Proceed to Student Health Services, if needed.
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Introduction
When in Doubt, Read This
Laboratory experiments supplement class lectures by providing exercises in analysis,
design and realization. The objective of the laboratory is to present concepts and
techniques in designing, realizing, debugging, and documenting digital circuits and
systems. The laboratory begins with a review of Xilinx's VIVADO FPGA development
environment, which will be used extensively during the laboratory. Experiment #1
introduces the student to the fundamentals of the VIVADO and its tool set such as the
synthesizer, the test-bench user input program for the simulator, the VIVADO simulator,
and the FPGA implementation. Xilinx's FPGA development tools support VERILOG.
In Experiment #2, the basic operations found in the VIVADO will be used to design
and simulate a simple Boolean expression that will be using the student experimenter
kit using 74LSXXXX parts. Experiments #3 through #7 are experiments that deal
will the design and hardware implementation of combinational logic circuits. These
circuits will by designed using the VIVADO and implemented solely using an FPGA.
Experiments #8 through #11 deal with the design and hardware implementation of
sequential logic circuits and will also be designed and implemented using the FPGA and
VIVADO development tools. The VIVADO also offers an extensive set of manuals under
the Help menu. In addition to the electronic version of the manual and the Quick Sort
Tutorial, Xilinx offers many tutorials that are available on the web site at www.xilinx.com.
Laboratory Requirements:
This laboratory requires that each student obtains a copy of this manual, a bound quadruled engineering notebook and have access to Xilinx's VIVADO version 2017.4.The
student can use the VIVADO program on the laboratory computers or the student can
go to
https://www.xilinx.com/support/download/index.html/content/xilinx/en/downloadNav/vi
vado-design-tools/2017-4.html inorder to download the Vivado Design Suite - HLx Editions.
The student is to prepare for each laboratory by reading the assigned topics. The laboratory
notebook should contain the necessary tables, graphs, logic and pin assignment
diagrams and identify the expected results from the laboratory exercise as directed by
the pre-laboratory preparation assignments or by the laboratory instructor. Depending
on the laboratory assignment, the pre-laboratory preparation may be due at the beginning
of the laboratory period or may be completed during the assigned laboratory period. Be
informed that during each laboratory period the instructor will grade your notebook
preparation.
During the laboratory period you are expected to construct and complete each laboratory
assignment, record data, and deviations from your expected results, equipment used,
laboratory partners, and design changes in your laboratory notebook. A laboratory
performance grade will be assigned by the laboratory instructor upon successful
completion of the above-described tasks for each experiment.
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Each student will be assigned to a computer with an FPGA board connected to it. Each
student is responsible for his or her own work including design and documentation. A
Laboratory Report, following the guidelines presented in this handout is due the
laboratory period following the completion of the in-laboratory work or when the
instructor designates. A numeric grade will be assigned using the attached laboratorygrading sheet.
Laboratory reports will be due before the start of each laboratory. A penalty of five points
will be charged for those late by up to one week (0-7 days). No credit will be given for
laboratory reports over-due by more than one week. However, a student must complete
each assigned experiment in order to complete the laboratory. By not turning in a
laboratory report, a student will receive an incomplete for that report, which results in an
incomplete for the laboratory grade.
Students who miss the laboratory lecture should make arrangements to make up the
laboratory at a later time. Points may be taken off the laboratory experiment and the
student might not be allowed to attend the remainder of the laboratory because this will
burden the laboratory instructor and the rest of the laboratory that day.
Students who are late to their laboratory section will not receive the five pre-laboratory
points. A penalty of five points will also be charged for turning in a late laboratory report.
If, for some reason, a student cannot attend the regularly scheduled laboratory time
period, then he / she must make arrangements to make up the laboratory experiment at a
later time and hand in the laboratory report and pre-laboratory early to avoid a ten point
penalty.
Laboratory Point Breakdown
In-Laboratory Grade (10 points):
1. Pre-Laboratory Assignment.............................................................……..… 5 points
2. Design Completion...........................................................................…….… 5 points
Laboratory Report Grade (15 points):
3. Problem or Objective Statement, Block Diagram, and Apparatus List.…… 1 point
4. Procedure and Data or Design Steps.............…...................................….… 3 points
5. Results Statement and Logic Schematic Diagram................................…… 4 points
6. Design Specification Plan .………………………………………………… 2 points
7. Test Plan …………………………………………………………………… 2 points
8. Conclusion Statement........................................................................…….… 3 points
TOTAL.........................................................................................……….....…. 25 points
The final laboratory grade can be a percentage, an incomplete or a failing grade. If the
student receives an incomplete or failing grade for the laboratory, an incomplete may be
assigned for the whole course.
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Guidelines for Laboratory Reports:
The laboratory report is the record of all work pertaining to the experiment, which
includes any pre-laboratory assignments, Verilog code and Xilinx's VIVADO printouts
when applicable. This record should be sufficiently complete so that you or anyone else
of similar technical background can duplicate the experiment by simply following your
laboratory report. Original work is required by all students (NO PHOTOCOPIES
OR DUPLICATE PRINTOUTS). Your laboratory report is an individual effort and
should be unique. The laboratory notebook must be used for recording data. Do not trust
your memory to fill in the details at a later time. An engineer will spend 75 percent of
his/her time for documentation.
Organization in your report is important. It should be presented in chronological order
with descriptive headings to separate and identify the various parts of the experiment. A
neat, organized and complete record of the experiment is just as important as the
experimental work. DO NOT SECTION OFF DIAGRAMS, PROCEDURES, AND
TABLES.
The following are general guidelines for your use. Use the standard paper prescribed by
your instructor. A cover page is required for each laboratory including your name, PID,
name and number of the experiment, date of the experiment and the date the report is
submitted. Complete the required information and attach to the front of each report. If a
cover page is not included with a report, then points may be taken off.
The report should contain the following (not segmented or necessarily in this order):


Heading: The experiment number, your name, and date should be at the top right
hand side of each page.



Objective: A brief but complete statement of what you intend to design or verify
in the experiment should be at the beginning of each experiment.



Block Diagram: A block diagram of the circuit under test and the test equipment
should be drawn and labeled so that the actual experiment circuitry could be
easily duplicated at any time in the future.



Apparatus List: List the items of equipment, including IC devices, with
identification numbers using the UCF label tag, make, and model of the
equipment. It may be necessary later to locate specific items of equipment for
rechecks if discrepancies develop in the results. Also include the computer used
and the version number of any software used.



Procedure and/or Design Methodology: In general, lengthy explanations are
unnecessary. Be brief. Keep in mind the fact that the experiment must be
reproducible from the information given in your report. Include the steps taken in
the design of the circuit: Truth Table, assumptions, conventions, definitions,
Karnaugh Map(s), algebraic simplification steps, etc.
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Design Specification Plan: A detailed discussion on how your design approach
meets the requirements of the laboratory experiment should be presented. Given a
set of requirements there are many ways to design a system that meets these
requirements. The Design Specification Plan describes the methodology chosen
and the reason for the selection (why). The Design Specification Plan is also used
to verify that all the requirements of the project have been implemented as
described by the requirements.
.



Test Plan: A test plan describes how to test the implemented design against the
given requirement specifications. This plan gives detailed steps during the test
process defining which inputs should be tested and verifying for these inputs that
the correct outputs appear. The laboratory instructor will use this test plan to test
your laboratory experiment.



Results: The results should be presented in a form, which makes the
interpretation easy. Large amounts of numerical results are generally presented in a
graphical form. Tables are generally used for a small amount of results. Theoretical
and experimental results should be on the same graph or arranged in the same
table for easy correlation of these results. For digital data, prepare a simulation
and response table and record logic levels as "1"s and "0"s. The above table is
similar to a Karnaugh Map or State Transition Table. Identification of the size of a
logic circuit, in terms of number of inputs, gates and packages is often required in
a design-oriented experiment.



Conclusion: This is your interpretation of the objectives, procedures and results
of the experiment, which will be used as a statement of what you learned in
performing the experiment. This is not a summary. Be brief and specific but
complete. Identify the advantages and/or disadvantages of your solution in designoriented experiments. The conclusion also includes the answers to the questions
presented in each experiment.
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EXPERIMENT #1

Introduction to Xilinx’s
FPGA Vivado HLx Software

Goals: To introduce the modeling, simulation and implementation of digital circuits using
Xilinx's FPGA VIVADO HLx Editions design tools.

References: Within the VIVADO, there are several documentation and tutorials that are

available. In particular, the “Quick Take Videos” provides basic instructions such
as how to create a file using either VHDL or VERILOG. The VIVADO also offers
an extensive set of manuals under the Help menu. In addition to the electronic
version of the manual and the Quick Sort Tutorial, Xilinx offers many tutorials that
are available on the web site at www.xilinx.com.

Equipment: The Xilinx's FPGA VIVADO HLx Editions design tools are available in

the laboratory. These tools can also be downloaded from Xilinx's web site at
www.xilinx.com. The WebPack version of this tool that we use for the laboratory
experiments are located under the support download section at the related website
(https://www.xilinx.com/support/download/index.html/content/xilinx/en/downloa
dNav/vivado-design-tools/2017-4.html). Please take note that the file download
size exceeds 1 GB and also during the installation process updates may have to be
installed. It can take you up to a few hours to download and install the software on
your computer. The user does not need to have the BASYS development board
interface to the computer to design and simulate an FPGA.

Pre-laboratory: Read this experiment carefully to become familiar with the procedural
steps in this experiment.

Discussion: Xilinx's Vivado is an FPGA design, simulation and implementation tool set

that allows the designer the ability to develop digital systems using either schematic
capture or HDL using VERILOG or VHDL. These digital systems are then verified
using simulation tools that are part of the development system. Once the simulation
outputs meet the design requirements, implementation is simply assigning the
inputs and outputs to the appropriate pins on the FPGA. Appendix D gives the pin
configuration for the BASYS board by Digilent Inc. (www.digilentinc.com)
relating the LED and switch connections to the FPGA pin assignments.
Experiment #1 is divided into three sections. Part 1 of this experiment will guide
the student through the steps required to create a digital design using Verilog. Next,
the steps required to simulate this design are given along with the steps required to
synthesize and implement the design on the FPGA BASYS 3 board. Part 2 is an
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expansion of part 1 for additional logic gates (NAND, OR, XOR, NOT). In part 3,
a two-input five-output logic system is required to be designed and implemented.

Part 1. Introduction to the XILINX Vivado
In this part, you will use Xilinx's Vivado to design, simulate and implement a
simple 2 input AND gate digital circuit. Once completed, this 2 input AND gate
implementation will be downloaded to the BASYS board and then tested using the
on board LED's and switches.
1. Double click on the Vivado icon on your desktop to open up the welcome window of
the development tool (as shown below). Three main sections can be observed in this
window: “Quick Start”, “Tasks”, and “Learning Center”.

2. Now, click on “Create Project” to create a new project. You have to be careful about
where to save your project file in the computer lab. The computers in the lab run a
hard disk protection program that could interfere with Xilinx. So, if you save your
project in a preserved folder, Xilinx might have problem with running the simulation.
You have two choices: (1) either save the project directly on your USB flash disk.
This option is good since your USB disk have normal read/write access and Xilinx
runs correctly. However, this option can be slow for USB flash disks. The option (2)
is to save the project in a folder that’s in the desktop. Then, compress the folder into a
ZIP file and email it to yourself. Start by creating a folder on the desktop called
‘Lab_1’. Create this folder in Windows, not from Xilinx. Then, in Xilinx, create a
new project inside “Lab_1”. Name your project, ‘Test_1’ and it will be in the folder
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“\Desktop\Lab_1\Test_1”. When you finish your lab, you can copy your project on
your flash disk.

3. In the next window, choose “RTL Project” as the project type. You can the
description of this type in the window.
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4. In the opened window, you can create source file (Verilog/Verilog
Header/SystemVerilog/VHDL/Memory File) for your new project or add sources
from the existing projects. Click on “Create File”, and in the opened window choose
“Verilog” for the “File type”, write a name for your file (“Part_1”), and click on
“Ok”. Continue clicking on Next until reaching the “Default Part” window.
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5. In this window, choose “Artix-7” for the “Family”, “-1” for “Speed grade”, and
“cpg236” for “Package”. In the shown parts, select “xc7a35tcpg236-1”. Take a look
at the configuration of this part for your own familiarity.
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6. Look at your new project summary.

7. Define the input and the output ports of your module according to the shown window.
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8. The opened window is the main environment for your project that is called “Project
Manager”. You can explore it by seeing the options of each category in the toolbar on
top of the window. In the left side, you can see the “Settings”, “Add Sources”,
“”Language Template”, “IP Catalog”, “IP Integrator”, “Simulation”, “RTL Analysis”,
“Synthesis”, “Implementation”, and “Program and Debug”. Each of these serves a
part of the digital design flow. In the middle, you can see the windows for “Sources”,
“Properties”, “Project Summary”, and the reports and summaries for the execution of
the project files.
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9. Double click on the “Part_1.v” file (*.v) in the “Sources” window. The VERILOG
source file appears where the window is located in right side. Note that the module
shows the defined inputs and outputs that were selected previously.
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The syntax for VERILOG is very similar to C programming language. All
lines must end in a semicolon, and all comments use either // or / */. One
difference is that all inputs and outputs need two definitions. The first defines
if the I/O connection is an input or an output port and the second defines if
this input is a "wire" or a register "reg". For this experiment, only wires will
be used. Also, to set an output equal to an input the “assign” function must be
used (for combinational circuits). A summary of the VERILOG syntax is
given in Appendix E. Also, a reference website for Verilog is described as
(i.e. http://www.asic-world.com). The '~' symbol is the NOT operator, the
‘|’ symbol is the OR operator, the ‘&’ symbol is the AND operator and ‘^’
symbol is the XOR operator. Add the following lines to the VERILOG
program after the input and output definitions:
wire Inp_1, Inp_2, Outp;
assign Outp = Inp_1 & Inp_2;
This defines the code required to implement a two-input AND gate:
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Now that the design is finished, you must build the project. Click Run Synthesis
(1) on the left hand menu towards the bottom, on successful completion click on
Run Implementation. On successful completion of implementation click on “Open
Implemented Design” in the dialog box that appears. Proceed to the next steps.”
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10. We do the “RTL Analysis”. Expand the Open Elaborated Design entry under the RTL
Analysis tasks of the Flow Navigator pane and click on Schematic. The model (design)
will be elaborated and a logic view of the design is displayed. Notice that some of the
switch inputs go through gates before being output to LEDs and the rest go straight
through to LEDs as modeled in the file.
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11. Once RTL analysis is performed, another standard layout called the I/O Planning is
available. Click on the drop-down button and select the I/O Planning layout.

12. Notice that the Package view is displayed in the Auxiliary View area, Device
Constraints tab is selected, and I/O ports tab is displayed in the Console View area.
Also notice that design ports (led and swt) are listed in the I/O Ports tab with both
having multiple I/O standards. Move the mouse cursor over the Package view,
highlighting different pins. Notice the pin site number is shown at the bottom of the
Vivado GUI, along with the pin type (User IO, GND, VCCO…) and the I/O bank it
belongs to.
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13. The user should simply input the “Site” table next to the input/output to the desired pin.
From Appendix D, for BASYS board, SW0 is located on pin V17, SW1 is located on
pin V16 and LED0 is located on pin U16. These names can also be found inside the
parentheses below the switches and the ones in the right side of the LEDs on the board.
The value of I/O Std for all of these switches should be set to “LVCMOS33”.
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14. Select File > Save Constraints. Name and save the constraint file.
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15. Then we should simulate the design using the XSim Simulator. Click Add Sources
under the Project Manager tasks of the Flow Navigator pane. Select the Add or Create
Simulation Sources option and click Next. We create a new file for simulation, and
name it as Part_1_Sim.
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16. For the simulation file, we don’t need to set the I/O. Click OK in this step.
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17. Double click on the “Part_1_Sim.v” in the Sources window to type the following
contents into the file. Within the Test-bench file, the simulation step size and the
resolution can be specified in line 1. The Test-bench module definition begins on line
23. Line 33 instantiates the UUT (unit/module under test). Also, it should be
mentioned that the timescale for both the Verilog module and the test-bench
module is set to 1 ns/1 ps.
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18. Click on Run Simulation > Run Behavioral Simulation under the Project Manager tasks
of the Flow Navigator window. The test-bench and source files are compiled and the
XSim simulator is run (assuming no errors). Click on the “Zoom Fit” icon to see all the
spectrum of simulation.
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19. In the last part, let’s click on the Generate Bitstream on the left hand menu towards the
bottom. Vivado runs through both Run Synthesis and Run Implementation before it
generates the bitstream automatically. This process generates the *.BIT file needed to
program the FPGA. The following window will be opened if the bitstream is generated.
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20. Go to “Flow  Hardware Manager” in the toolbar. Turn ON your board by pushing
up its power switch. Click on “Auto Connect” icon in the Hardware Manager
window. Click on the board name “xc7a35t_0 (1)”. In the opened “Hardware Device
Properties” window, make sure the bit file is selected for the “Programming file”.
Next, right click on the board name and choose “Program Device…”. Once the status
of the board goes to “Programmed”, then you can check the design functionality on
the board by changing the state of switches.
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21. Check the operation for the two-input AND gate and fill out the following table.
Remember we have selected switch SW0 for input “Inp_1”, switch SW1 for input
“Inp_2” and led LED0 for the output “Outp”. Toggle the switches for the states shown
in the table below and fill in the output by observing LED0. This table should confirm
the truth table for a two-input AND gate.
SW0
0
0
1
1

SW1
0
1
0
1

LED0

Part 2. Implementation of the NAND, OR, XOR, and NOT GATES
using Xilinx's Vivado
1. Repeat the steps in part one of this experiment, but this time for a two-input
NAND gate (NAND2). Open a New Project, do not try to include a new
schematic file in the previous project.
2. Repeat the steps in part one of this experiment, but this time for a two-input
OR gate (OR2). Open a New Project, do not try to include a new schematic
file in the previous project.
3. Repeat the steps in part one of this experiment, but this time for a two-input
XOR gate (XOR2). Open a New Project, do not try to include a new schematic
file in the previous project.
4. Repeat the steps in part one of this experiment, but this time for an inverter
gate (NOT). Open a New Project, do not try to include a new schematic file
in the previous project. Use this truth table for the inverter circuit.
SW0
0

LED0
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1

Part 3. Implementation of a two-input five-output logic circuit.
1. Implement the two-input and five-output logic circuit using the described
steps Simulate the five-outputs for all possible inputs. Upload the finished
design into the BASYS board and verify its functionality using the following
table.
A
0
1
0
1

B
0
0
1
1

LED0 (S)

LED1(W)

LED2(X)

a
b

LED3(Y)

LED4(Z)

s
w
x
y
z

Important: It is recommended to follow the procedures in this laboratory manual for
writing the report for this experiment.
1. Summarize in your own words the steps required to complete every part of this
experiment. Include the screen-shots (e.g. alt + print-screen to place a screen into
the clipboard) of the process in your report to show the steps taken to complete
this experiment.
2. Include and discuss the simulated results.
3. Give the truth table.
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4. Follow the explanations in the Introduction section of this manual for details of
how to write a well-structured report.
5. Look at the announcements in the course webpage for more information
regarding this lab and what items to position in your report.
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EXPERIMENT #2

Multi-Function Gate

Objective:

To design and build a Multi-Function Gate using the Xilinx's FPGA Vivado tools and to document
the design. Xilinx's FPGA Vivado tools will be used to design, simulate and implement this multifunction gate to the BASYS 3 Board FPGA.

Discussion:

The Multi-Function gate in this experiment is a double input, single output gate that can be
instructed to perform four different logic operations by placing a control value on the inputs X and
Y. The instruction to this Multi-Function Gate is provided by the operation select bits, which thus
determine how the gate will act. Figure .1 shows the block diagram of such a gate. A and B form
the data inputs and F the single output. X and Y are the operation select lines.

A

Multi-Function Gate

F

B

X

Y
Figure 2-1: Block Diagram of Multi-Function Gate

Design Specifications:

The module should be synthesized such that for a given X and Y, F is a certain function of A and
B. When X=0 and Y=0, the multi-function gate acts as an AND gate, therefore, F=A AND B.
When, X=0 and Y=1, the multi-function gate acts as an OR gate. When X=1 and Y=0, the multifunction gate acts as a NOR gate. Finally, when X=1 and Y=1 the multi-function gate acts as a
NAND gate. The function codes are summarized in the table below.
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X

Y

Function

0

0

AND

0

1

OR

1

0

NOR

1

1

NAND

Figure 2-1: Function codes for the multi-function gate

Pre-Laboratory Assignments:

1. Read this experiment carefully to become familiar with the experiment.
2. Represent the output F as a function of X, Y, A and B on a truth table.
3. Write the minimum logic expression, as a sum-of-products for the function F.
4. Draw logic diagrams for the above expressions using AND's, OR's, and Inverters.

Procedure:
1. Design and simulate the Boolean module using the VERILOG language in the Vivado.
Generate printouts of the VERILOG file, timing diagram and test bench inputs. Be sure that
all the sixteen input conditions have been met for A, B, X, and Y. Set the test bench end time
to 4000 nano-seconds and the simulation end time also to 4000 nano-seconds. You may need
additional wires beyond the input and output wires (eg. Wire a, b, c, d, e, etc). Please take a
look at the screenshot below as a guidance for writing the code.
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2. Now implement the design this procedure and configure the FPGA so that A is on SW0 (=
V17), B is on SW1 (= V16), X is on SW6 (= W14), and Y is on SW7 (= W13). Also use LED7
(= V14) for the output F. Appendix D gives the pin details for the switches and the LEDs.
Assign package pin and upload the design bitstream file into the board.

Questions:

(To be incorporated within the Conclusion section of your lab report.)
1. Can this Multi-Function Gate be operated as an Inverter? If yes, explain how.
2. Will the change in the number of inputs or outputs affect the number of operation select lines?
Explain.
3. Will the change in the number of functions alter the number of operation select lines? Explain.
4. Have you met all the requirements of this lab (Design Specification Plan)?
5. How should your design be tested (Test Plan)?
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EXPERIMENT #3

Three-Bit Binary Adder

Objective:
•
•

To design a Binary Adder, which will add two binary words, three bits each, using discrete
gates.
To introduce iterative cell design techniques.

Discussion:

A Binary Adder can be designed as a parallel or serial adder with accumulation. For this
experiment, the parallel adder will be designed to add two binary digits, three bits each, X
(expressed as X2X1X0) and Y (expressed as Y2Y1Y0). The adder can be designed via the "brute
force" method in which three, six variable Karnaugh maps are used to implement the functions
representing the outputs of a three-bit addition. However, this method is not the most efficient so
a different design approach, called the iterative cell technique, will be used. In the iterative cell
technique, two binary numbers are presented in parallel to the cell as inputs. The rightmost cell
adds the least significant bit X0 and Y0 to form a sum digit S0 and carry digit C0. The next cell adds
the carry C0 to bits X1 and Y1 to form a sum digit S1 and a carry digit C1. The last cell adds the
carry C1 to bits X2 and Y2 to form a sum digit S2 and a carry digit Cout.

To design a network, a typical cell should be designed which adds a carry Ci to bits Xi and Yi to
generate a sum digit Si and a new carry Cout as shown below. The circuit that realizes this function
is referred to as a full adder cell. Please note that the operation on the least significant bits of X
and Y does not include a carry-in signal. Thus a half adder circuit can be used for the rightmost
cell. The diagrams below illustrate the functional blocks for a one-bit full adder and a one-bit half
adder.

Ci

Xi
Yi

One-bit
Full
Adder

Si

Xi

Cout

Yi
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One-bit
Half
Adder

Si
Cout

Pre-Laboratory Assignments:
1. Read this experiment carefully to become familiar with the requirements for this experiment.
2. Prepare and complete a truth table for the full adder cell. Transfer this information to a
Karnaugh Map and obtain minimum expressions in both sum of products and product of sums
forms.
3. Use Boolean algebra to reduce sum of products expression to a more workable expression. (i.e.
XOR’s).
4. Represent the full adder and the half adder as logic diagrams.
5. Prepare a Verilog code of the complete three-bit adder circuit (your best design). It should not
only include pin assignments but switch and LED assignments as well. See Appendix D for
pin details used by the BASYS 3 board.
Y2 X2 Y1 X1 Y0 X0

3-Bit Binary
Adder

Cout

S2 S1 S0

Procedure:
1. Use Verilog language to implement the design obtained in the pre-laboratory procedures. Use
a bus for input wires.
2. Assign SW0-SW2 to X0 - X2, SW5-SW7 to Y0 -Y2, LED0 - LED2 to S0 - S2 and LED7 to
Cout (carry out) on the BASYS 3 board. Download your design to the BASYS board using the
EXPORT program.
3. Verify that the three-bit adder adds the two binary numbers correctly on the BASYS 3 board.
Include this verification in your lab report.
4. Please take a look at the screenshot below for more information on how to write the code.
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Questions:

(To be incorporated in the Conclusion section of your laboratory report.)
1. Using full adder and half adder block diagrams, draw an 8-bit adder diagram.
2. Comment on the feasibility of designing an 8-bit adder using the brute force method.
3. Identify the advantages and disadvantages of the brute force method.
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4. Identify the advantages and disadvantages of the iterative cell method.
5. Have you met all the requirements of this lab (Design Specification Plan)?
6. How should your design be tested (Test Plan)?
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EXPERIMENT #4
Multiplexers in Combinational logic design
Objective:
The goal of this experiment is to introduce multiplexers in the implementation of
combinational logic design. In addition, procedural programming in VERILOG
will be introduced to the student.

Discussion:

Multiplexer or Selector:
The basic function of the circuit is to select one of several inputs to connect to a
single output line. Typical multiplexers (MUX’s) come in 2:1, 4:1, 8:1 and 16:1. A
MUX is composed of n selections bits that maps 2n inputs to a single output. A TTL
series 8:1 MUX is 74151, which is an eight to one (8:1) multiplexer. The data select
lines are S2, S1, and S0 (often called the control / selection lines). Each of the 8
possible combinations of S2, S1, and S0 selects one of the 8 AND gates which maps
one of 8 possible inputs to the output Y. The output of the selected AND gate will
be the same as the input signal on the corresponding data input line. All other AND
gate outputs will be ‘0’. The output of the OR function will be the same as the
output of the selected AND gate. In this way, the input data associated with a
selected line is routed to the output signal line. This operation is called
Multiplexing. The 74151 has another input called the Enable Input (Ē). The bar on
the symbol specifies that the Enable input is active low. This means the output is
enabled when the input signal is zero. Otherwise, the output is set to one when the
recommended pull-up resistor is used. The Ē input allows two cascaded 8:1
multiplexers to be combined together to form a single 16:1 multiplexer. Although
multiplexers are primarily used for switching data paths they can also be used to
realize general logic functions.
Function:
F(w,x,y,z) = (To be given out by the laboratory instructor.)
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Pre-Laboratory Assignments:
1.

Given the Function F(w, x, y, z) generate this function’s truth table. Next, determine
the min-terms (the combination of w, x, y, and z for which the output function F is
one). These combinations determine the input locations of the multiplexer which are
set to one. The combinations, for which the output is zero, form the input locations of
the multiplexer which are set to zero.

2. Write down the Verilog code for the Multiplexer depending on the inputs and outputs.

Procedure:
1. Using Xilinx’s Vivado Design Tool and the VERILOG programming language, design
a 16:1 multiplexer.
2. Create the VERILOG source file which consists of the code for multiplexer and then
Save the project file. Another area of VERILOG programming is procedural
programming, wherein ‘if statement’, ‘for loop’, and ‘case statement’ can be used. For
this experiment, a procedural program will be written that implements a 16:1
multiplexer.
A procedural Verilog code looks like this:
always @(<sensitivity list>)
begin
<insert code here…>
end
The procedural code starts with the ‘always’ keyword and the sensitivity list. The
sensitivity list will be replaced with events. When the event happens, the code between
‘begin’ and ‘end’ will be executed. Otherwise, this code won’t be run.
Two possible choices in the sensitivity list are the ‘posedge’ and ‘negedge’ keywords.
They are used to indicate the positive edge and the negative edge of a signal, usually a
clock signal. In the code line below, the procedural code is triggered when a positive
edge of the clock happens.
always @( posedge clock)
begin
<insert code here…>
end
Another option in the sensitivity list is a signal’s name. For example, let’s say our
Verilog module has an input called ‘S’. The procedural code below is triggered when
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the signal ‘S’ changes. That is, when ‘S’ changes from 0 to 1 or when ‘S’ changes from
1 to 0, the procedural code between ‘begin’ and ‘end’ runs.
always @( S)
begin
<insert code here…>
end
We have the choice or putting more than one signal in the sensitivity list. The code
below triggers the procedural code when either ‘S’ or ‘Q’ changes. Notice here, we use
the keyword ‘or’. This is not an OR gate. For a regular OR gate, use the symbol ‘|’.
Alternatively, we can trigger the procedural code when both of the signals ‘S’ and ‘Q’
change, as in the second line below.
always @(S or Q) …
always @( S and Q) …
Now, let’s look at the combinational code (or logic code) that was in the previous lab
and convert this code to procedural code. This is the example code from the previous
lab:
// *** Combinational (or Logic) Code ***
module temp(A, O);
input [1:0] A;
output O;
assign O = A[0] & A[1];
endmodule

// input of 2 bits
// output of 1 bit

The equivalent procedural Verilog code is shown below. The header and the
input/output declarations are the same. Notice, however, in the procedural code, the
output ‘O’ is also declared as a register in the line ‘reg O;’. It is a rule that any output
that is assigned a value in a procedural code (that is, between the ‘begin’ and ‘end’
keywords) should be defined as a register. We can also define ‘O’ as output and as
register in one line by writing “output reg O;”.
The next thing is to decide what to put in the sensitivity list. In this code, when any bit
in the input changes (whether A[1] or A[0]), we need a new evaluation of the output
‘O’. So we put A in the sensitivity list. If either A[1] or A[0] changes, the total value
of ‘A’ will change. We could have also used ‘always@(A[1] or A[0])’.
Between ‘begin’ and ‘end’ keywords, we assign ‘O’ its value. Notice that, here, we
don’t use the ‘assign’ keyword since ‘O’ is declared as a register. The register is a
container that contains data so we don’t need to do a continuous assignment which is
done by ‘assign’.
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// *** Procedural Code ***
module temp(A, O);
input [1:0] A;
output O;
reg O;
// Declare the output as register!
always @(A)
begin
O = A[1] & A[0];
end
endmodule
Verilog also has some advanced features that we can use in the procedural code such
as ‘nonblocking assignment’ and ‘blocking assignment’. Assume we have a register
‘A’=5 and a register ‘C’=10. The code below uses blocking assignments since it uses
the ‘=’ sign. It means, C is assigned to A (therefore C=5) and, after that, B is assigned
to C (therefore B=5). This is the same way as a programming language like C or Java.
always@(<sensitivity list>)
begin
C = A;
B = C;
end
Another way to do assignments is nonblocking assignments where the assignments
occur in parallel. In the code below, the assignments are done using the ‘<=’ sign. It
means the two assignments happen simultaneously. Starting with ‘A’=5 and ‘C’=10,
we get: C=5 and B=10, unlike the result above.
always@(<sensitivity list>)
begin
C <= A;
B <= C;
end
‘If conditional statements’, ‘for loops’ and ‘case statements’ can be used within a
procedural block. The code below shows an example of using a case statement for a
two-bit input B:
module test(clock, A, B);
input clock;
// A clock signal
input [1:0] A;
// input of 2 bits
output B;
reg B;
// Declare B as register since we use procedural code
always @( posedge clock)
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begin

end

case (A)
2'b00: B = 0;
2'b01: B = 1;
2'b10: B = 1;
2'b11: B = 0;
endcase

// Starting the case statement

// Ending the case statement

Notice the syntax that we used to check the value of A. The first line is: 2’b00. This
means the value we’re checking is 2 bits and in binary. For example, if we want to
compare to the 4-bit binary value of 1101, we would write: 4’b1101. We could also
provide the values in decimal. The code above becomes:
always@(posedge clock)
begin
case (A)
0: B = 0;
1: B = 1;
2: B = 1;
3: B = 0;
endcase
end
Another way to write this procedural code is by using if-else statements as in the code
below.
always@(posedge clock)
begin
if(A==0)
B=0;
else if(A==1)
B=1;
else if(A==2)
B=1;
else
B=0;
end
For the sixteen inputs, hardcode the function F(w, x, y, z) using the assign operator.
Simulate this VERILOG 16:1 multiplexer and compare the simulation output to the
truth table developed for the experiment. Use the count up option in the UUT
waveform tool to vary the select input S from 0000 binary to 1111 binary.’
3. Click on Run Synthesis on saving the project. Once it is successfully completed, Click
on Run Implementation.
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4. Once RTL analysis is performed, another standard layout called the I/O Planning is
available. Click on the drop-down button and select the I/O Planning layout. Expand
the Open Elaborated Design entry under the RTL Analysis tasks of the Flow
Navigator pane and click on Schematic to obtain the design that is created. Obtain a
screenshot of the generated diagram to reproduce it in the report.

5. Expand the Open Synthesized Design under Synthesis tab of the Flow Navigator to
obtain the Package View of the design generated. Assign the package pins
accordingly. The 4-Bit Inputs will be assigned to the switches SW0 (V17), SW1
(V16), SW2(W17), and SW3(W15) and the O output should be linked to LED0
(LD0) on the BASYS3 board. These names can also be found inside the parentheses
below the switches and the ones in the right side of the LEDs on the board. The value
of I/O Std for all of these switches should be set to “LVCMOS33”.
6. Once the package pins are assigned, save the constraints file by clicking ‘File’ > ‘Save
Constraints’. Name and save the constraint file.
7. Then we should simulate the design using the XSim Simulator. Click Add Sources
under the Project Manager tasks of the Flow Navigator pane. Select the Add or Create
Simulation Sources option and click Next. We create a new file for simulation
“’*_Sim.v”. For the simulation file, we don’t need to set the I/O. Click OK in this
step.
8. Double click on the “’*_Sim.v”. in the Sources window to type in the time constraints
into the file. Within the UUT, the simulation step size and the resolution can be
specified in line 1. The Test-bench module definition begins on line 23. Line 33
instantiates the UUT (unit/module under test). Also, it should be mentioned that the
timescale for both the Verilog module and the test-bench module is set to 1 ns/1 ps.
9. Click on Run Simulation > Run Behavioral Simulation under the Project Manager
tasks of the Flow Navigator window. The test-bench and source files are compiled
and the XSim simulator is run (assuming no errors). Click on the “Zoom Fit” icon to
see all the spectrum of simulation.
10. In the last part, let’s click on the Generate Bitstream on the left hand menu towards the
bottom. Vivado runs through both Run Synthesis and Run Implementation before it
generates the bitstream automatically. This process generates the *.BIT file needed to
program the FPGA. The following window will be opened if the bitstream is generated.
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11. Go to “Flow  Hardware Manager” in the toolbar. Turn ON your board by pushing
up its power switch. Click on “Auto Connect” icon in the Hardware Manager
window. Click on the board name “xc7a35t_0 (1)”. In the opened “Hardware Device
Properties” window, make sure the bit file is selected for the “Programming file”.
Next, right click on the board name and choose “Program Device…”. Once the status
of the board goes to “Programmed”, then you can check the design functionality on
the board by changing the state of switches.

Questions:
(To be incorporated within the Conclusion section of your lab report.)
1. Investigate the function of a lookup table and describe how one works.
2. Consider a 16 word by 1 bit lookup table. Give the values stored in each location
0000 binary (word zero) to 1111 binary (word fifteen) for the function F(w, x, y, z).
The truth table that was generated in the pre-laboratory will help here.
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EXPERIMENT #5

Decoder and Demultiplexer

Objective:

To introduce decoders and their use in selecting one output at a time. Both the schematic capture
tool and the VERILOG design language will be used to implement a 3 to 8 and a 4 to 16 decoder

Discussion:
Decoder and Demultiplexer –
The Decoder performs an opposite function to that of the multiplexer. It connects one input line
to one of several output lines. A decoder is another combinational logic device that acts as a
"minterm detector". A decoder can be made by using a demultiplexer with its input as ‘1’.
Examine the spec sheet in Appendix A (starting on page 9 of Appendix A) for 74155. For an
input word of n-bits, the decoder will have 2n outputs, one for each minterm 0 to 2n-1. When a bit
pattern is placed on the decoder's inputs (which corresponds to a minterm), the corresponding
decoder output will be ‘0’ while the non-selected outputs will be ‘1’. Since the outputs are
inverted (active low), a NAND gate is used to "OR" the minterms. The enable inputs allow for
connecting two or more 74155’s together to decode longer words. Logic functions can be
implemented rather easily with a decoder. Rather than wiring logic gates to realize a sumofproducts, the desired minterms can be obtained by OR-ing the appropriate outputs from the
decoder with a NAND gate if the outputs are active low or an OR gate if the decoder outputs are
active high.
E
W

3:8
Decoder :.
x

y

z

E

+5

3:8
Decoder :.
x

y z

Figure 6-1: Cascaded Decoders

5-1

f2(w,x,y,z)

Functions:
•
•

f(a, b, c) = SPECIFIED BY THE LAB INSTRUCTOR
g(w, x, y, z) = SPECIFIED BY THE LAB INSTRUCTOR
(You may have to expand the equation to obtain minterms containing all the input variables.)

Pre-Lab Assignments:
1. Read this experiment to become familiar with this experiment.
2. Draft the Design Specification Plan.
3. Draft the Test Plan for the experiment.
4. Represent the two functions in a truth table and in the minterm list form. For the three input

functions, obtain a schematic diagram using one 3-to-8 decoder (active high) and an OR gate.
For the four input function, two 3-to-8 decoders will be needed.

Figure 6-2: 3-to-8 Decoder Component

Procedure:
1. Create the VERILOG source file which consists of the code for multiplexer and

then Save the project file.
One way to implement the decoder is to use if-else statements, which have the
following format:
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if(expression)
begin
program code
end
else if(expression)
begin
program code
end
else
begin
program code
end
The conditional operators that can be used with an if statement, are the same as C
programming language:
<
less than
<=
less than or equals
>
greater than
>=
greater than or equals
== equal to
!=
not equals
Vivado will create a template for your code. You need to fill the procedural code that
implements a decoder.

module mydecoder24vlog (en, in, out);
input en;
input [1:0] in;
output [3:0] out;
????
always@(????)
begin
if(en==1)
case(in)
2'b00: out = 4'b0001;
2'b01: ???
???
???
Endcase
else if(en==0)
begin
out = ???
end
end
endmodule

// Enable signal
// Declare ‘out’ as a register
// Fill the sensitivity list

// Fill this line
// Fill this line
// Fill this line

// What should ‘out’ be?
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First, add a line to declare the output ‘out’ as a register. We need to do this since we’ll
assign a value to ‘out’ in the procedural code (between ‘begin’ and ‘end’ keywords).
Remember, the register of ‘out’ should be the same size as the signal ‘out’ (that is, 4
bits).
Then, fill the sensitivity list. You should ask the question: when should this code refresh,
that is, run again? Typically, a code should refresh if any one of its inputs changes.
The first if-statement checks if the enable signal is 1. If it is, the decoder will see the
value of the input to determine which output to assert. Only one output will be ‘1’ in this
case and the other outputs are ‘0’. In the first line of the case statement, if the input is 00,
the output is 0001. That is, the line out[0] is ‘1’ and the other output lines are ‘0’. Fill the
remaining lines in the case statement.
Finally, if the enable is ‘0’, all the outputs should be ‘0’. This assignment can be done in
one line. Fill it in the code.
The figure below shows you the 3-to-8 decoder that we will build in VERILOG. We will
use a programming mode in VERILOG called ‘structural’. In the structural mode, we
describe the structure of the circuit, which we have in the figure below. By looking at the
figure, we can see that we need two 2-to-4 decoders (we’ll use the procedural model that
we created ‘mydecoder24vlog’) and one inverter. VERILOG has the inverter ready made
for us, so we can use it.

Figure 6-3: A 3-to-8 Decoder Built with Two 2-to-4 Decoders
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Now, let’s look at the code template that Xilinx created for us for the 3-to-8 decoder in
the file ‘mydecoder38vlog’. In the code below, we added a new variable of type ‘wire’
that we called ‘wire1’. Why do we need the wire? If we look at the figure above, we can
see that every signal is either an input (I0, I1, I2) or an output (O0 through O7).
However, the line going out of the inverter and into the enable of the lower d ecoder is
neither an input nor an output to the 3-to-8 decoder. It is an internal wire. So we can use
the ‘wire’ type in VERILOG to take care of this connection.
module mydecoder38vlog (in, out);
// 3-bit input
input [2:0] in;
output [7:0] out;
// 8-bit output
wire wire1;
// Declaring a wire
//module mydecoder24vlog (en, in, out);
mydecoder24vlog decoder1 (in[2], in[1:0], out[7:4]);
mydecoder24blog decoder0 (???, ???, ???);
not inverter0 (wire1, in[2]);
endmodule
Now, we’ll declare two instances of the module ‘mydecoder24vlog’ to make the 3-to-8
decoder. Since the 2-to-4 decoder module is in the same folder, Xilinx will find it. The
first line declares a 2-to-4 decoder and calls is ‘decoder1’. You can call this name
anything you want. It’s like in C language when we write ‘int x;’. The term ‘int’ is the
variable type and the term ‘x’ is the variable name that we can call anything we want.
Here, the type is ‘mydecoder24vlog’, the module that we wrote earlier. Also, notice that
we put the header of ‘mydecoder24vlog’ commented out. We need the header because
when we make an instance of the 2-to-4 decoder, we need to provide the input and
output in the same order as in that module. Therefore, we should provide the enable
signal first, the input (a bus of 2 bits) second and finally, the output, a bus of 4 bits. By
looking at the figure, we can see that the enable signal of the upper decoder is ‘I2’,
therefore, we replace it with ‘in[2]’. We have also filled the input and output signals of
the upper decoder. Fill the instance line of the second decoder. For the inverter, we
should provide the output first, ‘wire1’, and then the input second, ‘in[2]’, as in the
figure.
2. Click on Run Synthesis on saving the project. Once it is successfully completed, Click

on Run Implementation.

3. Once RTL analysis is performed, another standard layout called the I/O Planning is

available. Click on the drop-down button and select the I/O Planning layout. Expand
the Open Elaborated Design entry under the RTL Analysis tasks of the Flow
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Navigator pane and click on Schematic to obtain the design that is created. Obtain a
screenshot of the generated diagram to reproduce it in the report.
4. Expand the Open Synthesized Design under Synthesis tab of the Flow Navigator to

obtain the Package View of the design generated. Assign the package pins
accordingly. The 2-Bit Inputs will be assigned to the switches SW0 (V17), SW1
(V16), SW2(W17), and SW3(W15) and the O output should be linked to LED0
(LD0) on the BASYS3 board. These names can also be found inside the parentheses
below the switches and the ones in the right side of the LEDs on the board. The value
of I/O Std for all of these switches should be set to “LVCMOS33”.

5. Once the package pins are assigned, save the constraints file by clicking ‘File’ > ‘Save

Constraints’. Name and save the constraint file.

6. Then we should simulate the design using the XSim Simulator. Click Add Sources

under the Project Manager tasks of the Flow Navigator pane. Select the Add or Create
Simulation Sources option and click Next. We create a new file for simulation
“’*_Sim.v”. For the simulation file, we don’t need to set the I/O. Click OK in this
step.

7. Double click on the “’*_Sim.v”. in the Sources window to type in the time constraints

into the file. Within the UUT, the simulation step size and the resolution can be
specified in line 1. The Test-bench module definition begins on line 23. Line 33
instantiates the UUT (unit/module under test). Also, it should be mentioned that the
timescale for both the Verilog module and the test-bench module is set to 1 ns/1 ps.

8. Click on Run Simulation > Run Behavioral Simulation under the Project Manager

tasks of the Flow Navigator window. The test-bench and source files are compiled
and the XSim simulator is run (assuming no errors). Click on the “Zoom Fit” icon to
see all the spectrum of simulation.

9.

In the last part, let’s click on the Generate Bitstream on the left hand menu towards the
bottom. Vivado runs through both Run Synthesis and Run Implementation before it
generates the bitstream automatically. This process generates the *.BIT file needed to
program the FPGA. The following window will be opened if the bitstream is generated.

10. Go to “Flow  Hardware Manager” in the toolbar. Turn ON your board by pushing

up its power switch. Click on “Auto Connect” icon in the Hardware Manager
window. Click on the board name “xc7a35t_0 (1)”. In the opened “Hardware Device
Properties” window, make sure the bit file is selected for the “Programming file”.
Next, right click on the board name and choose “Program Device…”. Once the status
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of the board goes to “Programmed”, then you can check the design functionality on
the board by changing the state of switches.
11. See Experiment #1&2 on how to design, set the test bench end time and the

simulation end time. Once the simulation is completed, verify if the outputs are in
sync with code.

12. Download the design in Step 1 to the BASYS board with A0 = SW0(V16), A1 =

SW1(V17), A2 = SW2(W17) and the output = LED0(LD0) to LED7(LD7) using the
package pins. Generate a new truth table to verify that the design works correctly.

Questions:

(To be incorporated within the Conclusion section of your lab report.)

1. If the decoder has active low outputs (74155) instead of active high outputs as the case for
D3_8E 3-to-8 decoder, why can a NAND gate be used to logically OR its outputs?

2. Which MSI function, multiplexer or decoder would best implement multiple output functions
(i.e. many functions of the same input variables)? Why?

3. What are the advantages of using an FPGA over MSI devices or SSI devices?
4. In this experiment, the enable line is used to obtain a 4-to-16 decoder. What needs to be added
to obtain a 5-to-32 decoder using the D3_8E 3-to-8 decoders? Draw a schematic of a 5-to-32
decoder (using four D3_8E 3 to 8 decoders).

5. Write the Test Plan of how this experiment should be tested.
6. Write the Product Specification Plan to verify that the all the requirements have been meet.
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EXPERIMENT #6

Random Access Memory

Objective:

To examine the use of RAM (and ROM) as means of realizing combinational logic circuits.

Discussion:

Read/Write Memory (RAM): RAM is a memory device which can be used as another means of

implementing combinational logic. A memory device is a MSI (Medium Scale Integration), LSI
(Large Scale Integration) or VLSI (Very Large Scale Integration) circuit, depending on the
memory size circuit. The RAM chip contains an array of semiconductor devices, which are
interconnected to store an array of binary data. Data words are stored in different locations on a
RAM, each location being unique. These locations are accessed by addresses. The word length
and the number of addresses depend on the size of a particular RAM. Data words can be written
into or read from the RAM by accessing it with the desired or respective address. RAM is a
volatile memory device. It must be "powered" on whenever data is to be written or read from it,
and it loses all the stored information when the power is shut off. One of the advantageous
features of this device is that it allows for the change in the stored data during the operation. A
typical FPGA can implement memory devices in several different word lengths and word widths.
For this experiment, the memory device of interest will be the 32 word by 4 bit (ram32x4s) static
random access memory. Memory expansion or "cascading" is achieved through multiple chip
select inputs.
Read Only Memory (ROM): A Read-Only Memory (ROM) is an LSI or VLSI circuit, which
consists of coupling devices (most often diodes). Binary data is stored in the ROM by coupling
an address minterm line (word line) to an output line (bit line). It can be read out whenever
desired, but the data which is stored cannot be changed under normal operating conditions. A
ROM with n input lines and m output lines contains an array of 2n words and each word is m bits
long. The input lines serve as an address to select one of the 2n words. When an input
combination is applied to the ROM, the pattern of 0's and l's which is stored in the corresponding
word in the memory appears at the output lines. The basic structure of the ROM consists of a
decoder and a memory array. The n inputs are directed to the n inputs of the decoder and when a
pattern of n 0's and l's is applied to the input, exactly one of the decoder outputs is 1. The decoder
output pattern stored in this word is transferred to the memory output lines. Unlike the RAM, the
ROM is a nonvolatile memory device and what is stored at each location can not be changed.

Pre-Laboratory Assignment:
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1. Read this experiment carefully to become familiar with the experiment.
2. Read section 9.6 of the Roth text for further discussion on ROM.
3. Given the Function F1(w, x, y, z) and F2(x1, x0, y1, y0), write the truth table for each function.
F1(w, x, y, z) - Specified by the lab instructor
F2(x1, x0, y1, y0) is a two bit adder. The function F2(x1, x0, y1, y0) has 3 outputs - 2
bits for the sum and 1 bit for the carry out Cout.
4. The variables w, x, y and z or x1, x0, y1 and y0 are inputs that are tied to the address lines of
the RAM or ROM. Prepare a truth table with inputs A3, A2, A1 and A0 from 0000 to 1111
(16 combinations representing w, x, y and z or x1, x0, y1 and y0) and outputs O0, O1, O2 and
O3. O0 represents the output of the function F1(w, x, y, z), O1 and O2 represents the two bits
for the sum and O3 represents the carry out Cout bit. The truth table should have the following
columns:
A3 A2 A1 A0 O0 O1 O2 O3
0

0

0

0

0

0

0

1

1

1

1

1

Each of the input word 0000 to 1111 represents one memory location of the RAM. The output of
each word represents the data to be written in the corresponding memory location. Since in this
experiment you have 16 input words, you need 4 address lines A3 – A0. The line A4 can be
grounded.
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5. Write the test plan and constraints code of this experiment on how it should be tested.
6. Write the Design Specification Plan for this experiment

Procedure:

1. Using Xilinx’s Vivado and its Verilog source code generation, implement the 32 word by
4 bit design given in the pre-laboratory section and the write the Verilog source code to
generate schematic of the pre-laboratory assignment.
The Verilog Code can be implemented using
always @ (posedge clk)
begin
if (write)
addr_=??????
Data <= ????
end
2. Synthesize and implement this device. The data will be written into the RAM on the Basys
3 board.
3. See Experiment #1&2 on how to design, set the test bench end time and the simulation end
time. Once the simulation is completed, verify if the outputs are in sync with code.
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4. Generate programming file. Download the implemented design to the Basys-3 board.
Download the design in Step 1 to the Basys-3 board address pins, data pins, write button
and clock button along with the output LED’s using the package pins. Generate a new
truth table to verify that the design works correctly.
5. To write to this memory device, the address 0000 to 1111 will be used. The inputs A3 - A0
of the truth table in Step 4 of the pre-lab form the input to the address lines. The data to be
written (O3-O0 of the truth table) is selected on D0 - D3. The WE is selected high first and
while pressing WE (state ‘1’) press the WCLK line (state ‘0’ to ‘1’ when the push button
is pressed and back to ‘0’ when the push button is released). On the rising edge of WCLK,
the data on the data lines (SW4 – SW7) will be written in the address specified by the
address lines (SW0 – SW3).
6. Write into all the 16 address locations 0000 to 1111 of the RAM by each time selecting a
particular address on SW0-SW3 and the corresponding data on SW4-SW7 and enabling
WE and creating a ‘0’ to ‘1’ pulse on WCLK.
7. When the push button for WE is not pressed then the state is WE = 0 i.e. the RAM is in the
read mode. Now feed in the 16 address locations in the address line (SW0 – SW3) and
verify that the LED outputs match with the truth table of Step 4 of the prelab.
8. Verify that the function F1(w, x, y, z) is written into the RAM and verify that it implements
this function correctly. Generate a truth table of the implemented design.
9. Verify that the function F2(x1, x0, y1, y0) is written into the RAM and verify that it
implements this function correctly. Do not forget that this function has 3 outputs. Verify
that function F2 performs a two-bit addition correctly. Generate a truth table of the
implemented design.

Questions:

(To be incorporated within the Conclusion section of your lab report.)
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1. Discuss the advantages of using RAM for implementing combinational functions.
2. Which one is more practical, read/write memory or read only memory? Explain.
3. Some memory devices have only one set of data lines for both input and output. What is the
advantage and disadvantage of having the input and output lines separately or shared?
4. Have you met all the requirements of this lab (Design Specification Plan)?
5. How should your design be tested (Test Plan)?
6. What is the advantage of using RAM or ROM memory to implement combinational logic?
7. How can two 32x4s devices be combined together to form one 64 by 4 bit memory system?
(Hint: 8 - 2 to 1 multiplexers can be used in the design).
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EXPERIMENT #7

Flip-Flop Fundamentals

Objective:

To build and investigate the operation of an asynchronous SR flip-flop, clocked SR flipflop and clocked D flip-flop.

Discussion:
Asynchronous SR Flip-flop:
An asynchronous (un-clocked) SR flip-flop is easily represented by two cross-coupled
NAND gates preceded by two inverters as shown in Figure 8-1. When inputs S and R are
both ‘0’, the outputs are stable; when S = l and R = 0, Q is set to ‘1’ ( is set to ‘0’); and
when S = 0 and R = l, Q is reset to ‘0’ ( is set to ‘1’). The SR flip-flop operation is
undefined when both inputs S and R are set to ‘1’. This condition is analogous to the flipflop being set and reset at the same time thus causing an ambiguous output condition where
Q = = ‘1’. The state transition table for this SR flip-flop is shown in Figure 8.3. Qv is the
present state and Qv+1 is the new state for the output Q.

S

Q
Q

R
Figure 7-1: Asynchronous SR Flip-Flop

S

R

Q
Q

Figure 7-2: Asynchronous SR Flip-Flop Block Diagram

R

S

Qv Qv+1

0

0

0

0

0

0

1

1

0

1

0

1

0

1

1

1

1

0

0

0

1

0

1

0

1 (Not Allowed) 1 (Not Allowed)

0

1

1 (Not Allowed) 1 (Not Allowed)

1

1

Figure 7-3: Asynchronous SR Flip-Flop State Transition Table
Clocked SR Flip-flop:
A clocked SR flip-flop is created by ANDing (or windowing) the S and R inputs with a
clock. The SR flip-flop as shown in Figure 8-1 has inverters on the inputs. The AND gate
and the inverter can be replaced with a NAND gate as shown in Figure 8-4. Figure 8-5
gives its schematic representation.

S

Q
Q

R
C
Figure 7-4: Clocked SR Flip-Flop

S

Q

C
R

Q

Figure 7-5: Clocked SR Flip-Flop Block Diagram

The clock is represented by the line C. When the clock is high or ‘1’, then the device
operates similar to an asynchronous SR flip-flop. However, when the clock is low or ‘0’
then the outputs are stable and not permitted to change or "latched". The clock acts as a
window. When it is high, the flip-flop becomes sensitive to the inputs but when the clock
falls low, the output state can no longer change and is therefore determined by the last set
or reset condition on the S and R inputs. Thus the device is no longer sensitive to changes
on the inputs beginning at the falling edge of the clock. Only when the clock goes back to
‘1’ will the device become sensitive to the inputs again. This clocked SR flip-flop is also
sometimes referred to as a positive level SR flip-flop.
Clocked D Flip-flop:
A D Flip-flop or LATCH can be created by adding an inverter between the S and R inputs
of the clocked SR flip-flop, as shown in Figure 8.6. Its schematic input is given in Figure
8.7. The input is now referred as the Data or D input. When the clock is one, whatever
appears on the D input appears on Q and when the clock goes from a ‘1’ to a ‘0’, the last
value on the D input is the value held on the Q output.

D

Q
Q
C
Figure 7-6: Clocked D Flip-Flop

D

Q

C
Q

Figure 7-7: Clocked D Flip-Flop Block Diagram

The state transition table for the D flip flop is given in Figure 8-9. This table only has 4
rows, one for D and one for the present state Qv. The new output Qv+1 is equal to the D
data input.
S

Q
Q

R
C

Figure 7-8: Clocked D Flip-Flop Block Diagram
D (Data) Qv Qv+1
0

0

0

0

1

0

1

0

1

1

1

1

Figure 7-9: Clocked D Flip-Flop State Transition Table

There is an important difference in the testing of the circuits with memory. The test
sequence is no longer an application of all of the possible inputs. The sequence must
consider the state or value of the memory of the circuit. For the SR flip-flop, the S and R
inputs must first put the flip-flop in a known state (e.g., SR = 01 resets Q to 0). The next
inputs of SR=00 are used to check the condition SRQ+ = 000. Since Q will remain 0, the
next inputs of SR = 01 will test the condition SRQ+ = 010. In this way, a test sequence is
developed and used to program the test bench of Xilinx’s ISE for testing (i.e. the sequence
SR = 01, 00, 01… developed above is the start of the test sequence). For the SR flip-flop,
there are two inputs S and R. The state transition table of Figure 8-3 has eight rows to count
for the present state Qv. The inputs that form the transition table are S, R, and Qv.

Procedure:

1. Design and simulate the asynchronous SR flip-flop circuit using Xilinx Vivado.
Create VERILOG source file and then expand the Open Elaborated Design entry under
the RTL Analysis tasks of the Flow Navigator pane and click on Schematic to create
the schematic circuit. During the simulation make sure that all rows of the transition
table are simulated. Set the test bench to have enough time cycle through all possible
inputs and present values for Qv. See Experiment #1&2 on how to design, set the test
bench end time and the simulation end time.

2. Configure the Basys 3 board * (simply input the “Site” table next to the input/output
to the desired pin) . From Appendix D, for BASYS 3 board, R is on SW0 (PIN V17)
and S is on SW1 (PIN V16). Also use LED0 (PIN U16) for the output Q.
3. Generate *.BIT file and download the configuration file to the BASYS 3 board. Verify
that the SR flip-flop works correctly.

4. Design and simulate the clocked SR flip-flop circuit using Xilinx Vivado. Create
VERILOG source file and then expand the Open Elaborated Design entry under the
RTL Analysis tasks of the Flow Navigator pane and click on Schematic to create the
schematic circuit. During the simulation make sure that all rows of the transition table
are simulated. Set the test bench to have enough time cycle through all-possible inputs
and present values for Q. See Experiment #1&2 on how to design, set the test bench
end time and the simulation end time.
5. Configure the BASYS 3 (simply input the “Site” table next to the input/output to the
desired pin). From Appendix D, for BASYS board the clock input is on SW7 (PIN
W13), R is on SW0 (PIN V17), and S is on SW1 (PIN V16). Also use LED0 (PIN
U16) for the output Q.
6.

Generate *.BIT file and download the FPGA configuration file for Steps 4 and 5 to
the BASYS board. Verify that the clocked SR flip-flop works correctly.

7. Design and simulate the clocked D flip-flop circuit using Xilinx Vivado. Create
VERILOG source file and then expand the Open Elaborated Design entry under the
RTL Analysis tasks of the Flow Navigator pane and click on Schematic to create the
schematic circuit. In the Verilog-based implementation of the clocked D flip-flop, do
not forget to use the always @(expression) operator. Make sure that the expression
used covers all conditions of D and of the clock input. Be sure to simulate all possible
conditions for D input and the present value of Qv. During the simulation make sure
that all rows of the transition table are simulated. Set the test bench to have enough
time cycle through all-possible inputs and present values for Qv. See Experiment
#1&2 on how to design, set the test bench end time and the simulation end time. See
some screenshots examples below.

8. Configure the FPGA (simply input the “Site” table next to the input/output to the
desired pin). From Appendix D, for BASYS board the clock input is on SW7 (PIN
W13), D is on SW0 (PIN V17). Also use LED0 (PIN U16) for the output Q and LED1.

9. Finalize the Test Plan of this experiment on how it should be tested.
10. Finalize the Design Specification Plan for this experiment.

Questions:

(To be incorporated within the Conclusion section of your lab report.)

1. What are the advantages and disadvantages of each flip-flop?
2. Draw an asynchronous SR flip-flop schematic using NOR gates.
3. Using the lectures textbook, look up level flip-flops versus edge flips-flops and discuss
the difference.
4. What are some applications that might require the use of flip-flops?
5. Another type of edge flip-flop is the Toggle (T) flip-flop. Discuss how this flip-flop
works and give its state transition table.
6. How can the VERILOG program that implemented the D flip-flop in this experiment
be converted to a positive edge or a negative edge D flip-flop?

EXPERIMENT #8

Designing with D-Flip flops:
Shift Register and Sequence Counter

Objective:

To introduce the student to the design of sequential circuits using D flip-flops. A 4-bit
parallel load register, used as a right shift register and as a left shift register, will be
implemented. Additionally, a set of D flip-flops will be used to design and build a sequence
counter.

Discussion:
Part 1: Shift Register

Given 4 D flip-flops with inputs D0, D1, D2, D3, and outputs O0, O1, O2, O3, a right shift
produces an output of D0  O0, O0  O1, O1  O2, and O2  O3. In this case, the original
content of O3 is lost.
A shift left operation produces an output of O0  O1, O1  O2, O2  O3, and O3  D3. In the
shift left case, the original content of O0 is lost.
A shift register can also have a parallel load feature that allows all of the D flip-flops to be
loaded in one clock edge to produce D0  O0, D1  O1, D2  O2, and D3  O3.
D0

D1

D2

D3

SHIFT

Load –
Shift

Clock

REGISTER

O0

O1
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O2

O3

Part 2: General Sequence Counter

A sequence counter, which counts in a fixed loop, is a sequential machine that transitions
from one state to the next at every clock edge. This counter has no inputs and is designed,
using memory elements (typically D flip-flops), to follow a specified sequence.
?

?

?

?

?
?

Pre-Laboratory Assignments:
Part 1: Shift Register

1. Read the description of the 7495 Shift Register found in Appendix A (A-5, A-6)
and analyze the logic diagram. This will help you understand how a parallel load
shift register works and design your own circuit.
2. Design a four bit right and left shift register that implements the following truth
table. Use AND gates, OR gates and 4 positive edge clocked D flip-flops.to
implement the design.
3. Create VERILOG source file for the design in Step 2 with D0 through D3, set to
SW0 – SW3 (PINS V17, V16, W16, and W17) and O0 through O3 set to LED0 to
LED3 (PINS U16, E19, U19, and V19). The LOAD input should be connected to
SW7 (PIN W13), L/R should be on SW6 (PIN W14), and the CLK input should be
connected to an input push button BTND (PIN U17), and then expand the Open
Elaborated Design entry under the RTL Analysis tasks of the Flow Navigator pane
and click on Schematic to create the schematic circuit.
CLK

LOAD

L/R Shift

O0

O1

O2

O3

↑

1

X

D0

D1

D2

D3

↑

0

0

D0

O0

O1

O2

↑

0

1

O1

O2

O3

D3
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4. A draft of the test plan.
5. A draft of the design specification plan

Part 2: General Sequence Counter

1. Obtain from your lab instructor the state sequence.
2. Referring to the lecture text, read the section on sequential design using D flipflops. Understand the steps to convert a state diagram to a state transition table.
3. Design the sequence counter assigned by the lab instructor, using D flip-flops.
4. Include in your design the state diagram, state transition table, legend, next state
equations, and schematic diagram.
5. A draft of the test plan.
6. A draft of the design specification plan

Procedure:
Part 1: Shift Register
1. Design the four bit left and right shift register using Xilinx Vivado (VERILOG
source file). Use four D flip-flops, one for each bit of storage. The clock input should
be connected to a push button so that every time the push button is pressed, the shift
register sees a clock pulse to either load data into it or shift its data left or right. Switches
are notorious of producing many edge transitions when they go from ‘on’ to ‘off’ or
‘off’ to ‘on’ (sometimes). These extra edges result in extra clock edges to the shift
register clock input when a single clock edge is expected. Since the D flip-flops are
edge triggered in the shift register, these extra edges result in the shifting of its bits by
more than one bit at a time.
2. Create the schematic circuit from the VERILOG file and simulate the circuit and
verify that it correctly implements the function of a left / right shift register.
3. Download the Verilog-based implemented circuit to the BASYS board with D0
through D3 set to SW0 – SW3 (PINS V17, V16, W16, and W17) and O0 through
O3 set to LED0 – LED3 (PINS U16, E19, U19, and V19). The LOAD input should
be connected to SW7 (PIN W13), L/R should be on SW6 (PIN W14), and the CLK
input should be connected to the down push button, BTND (PIN U17). You will
need to overwrite the pin for the CLK signal.
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4. Test your circuit on the board and write your observations in your lab report.

Part 2: Sequence Counter
1. Design the sequence counter using Xilinx Vivado. Consider the required number
of D flip-flops.
2. Create the schematic circuit from the VERILOG file and simulate the circuit of
final design in your lab report.
3. Simulate the circuit and verify that it correctly implements the function of the
sequence counter.
4. Download the Verilog-based implemented design into the BASYS board with O0
through ON set to LED0 to LEDN (N is the number of bits required to implement
the sequence counter). The PIN of LED0 is U16, and find the rest by yourself. The
CLK input should be connected to the down push button, BTND (PIN U17). Also,
generate a new state transition table to verify that the design works correctly.
Describe what you observed during this test in your lab report.

Questions:

(To be incorporated within the Conclusion section of your lab report.)
1. What happens if there is noise on the clock input for both part 1 and part 2?
2. How can the shift register of part 1 be expanded to 8 bits? Draw a schematic of this
shift register.
3. What happens to the shift register of part 1 if during the left shift operation O3 is
tied to D0?
4. What happens to the shift register of part 1 if during the right shift operation O0 is
tied to D3?
5. What problems may arise due to the placement of “don't cares” in the next states of
states that are not desired?
6. How would one avoid the problems that the “don't cares” might produce?
7. Discuss the issues of using switches as clock inputs to edge triggered devices.
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APPENDIX D
BASYS BOARD
DEVICE
Switches
SW0
SW1
SW2
SW3
SW4
SW5
SW6
SW7

PIN #
38
36
29
24
18
12
10
6

Push Buttons
BTN0
BTN1
BTN2
BTN3

69
48
47
41

LEDS
LED0
LED1
LED2
LED3
LED4
LED5
LED6
LED7

15
14
8
7
5
4
3
2

7-SEG Displays
CA
CB
CC
CD
CE
CF
CG
DP
ANODE 3
ANODE 2
ANODE 1
ANODE 0

25
16
23
21
20
17
83
22
34
33
32
26

25 MHz Clock

54

BASYS 2 BOARD
DEVICE
Switches
SW0
SW1
SW2
SW3
SW4
SW5
SW6
SW7

PIN #
P11
L3
K3
B4
G3
F3
E2
N3

Push Buttons
BTN0
BTN1
BTN2
BTN3

G12
C11
M4
A7

LEDS
LED0
LED1
LED2
LED3
LED4
LED5
LED6
LED7

M5
M11
P7
P6
N5
N4
P4
G1

7-SEG Displays
CA
CB
CC
CD
CE
CF
CG
DP
ANODE 3
ANODE 2
ANODE 1
ANODE 0

L14
H12
N14
N11
P12
L13
M12
N13
F12
J12
M13
K14

25 MHz Clock

B8

Ca
Cf
Ce

Cb

Cg

Cc

Cd

Display 3
Anode 3

DP
Display 1
Anode 1

Display 2
Anode 2

Display 0
Anode 0

To turn on a segment, a value of
0 is needed on the anodes and a
value of 0 on the appropriate
cathodes Ca-Cg and the
Decimal point DP

APPENDIX E

With permission from and thanks to Peter M. Nyasulu
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1. Introduction
Verilog HDL is one of the two most common Hardware Description Languages (HDL) used by integrated circuit
(IC) designers. The other one is VHDL.
HDL’s allows the design to be simulated earlier in the design cycle in order to correct errors or experiment with
different architectures. Designs described in HDL are technology-independent, easy to design and debug, and are
usually more readable than schematics, particularly for large circuits.
Verilog can be used to describe designs at four levels of abstraction:
(i) Algorithmic level (much like c code with if, case and loop statements).
(ii) Register transfer level (RTL uses registers connected by Boolean equations).
(iii) Gate level (interconnected AND, NOR etc.).
(iv) Switch level (the switches are MOS transistors inside gates).
The language also defines constructs that can be used to control the input and output of simulation.
More recently Verilog is used as an input for synthesis programs which will generate a gate-level description (a
netlist) for the circuit. Some Verilog constructs are not synthesizable. Also the way the code is written will greatly
effect the size and speed of the synthesized circuit. Most readers will want to synthesize their circuits, so nonsynthesizable constructs should be used only for test benches. These are program modules used to generate I/O needed to
simulate the rest of the design. The words “not synthesizable” will be used for examples and constructs as needed that
do not synthesize.
There are two types of code in most HDLs:
Structural, which is a verbal wiring diagram without storage.
assign a=b & c | d;
/* “|” is a OR */
assign d = e & (~c);
Here the order of the statements does not matter. Changing e will change a.
Procedural which is used for circuits with storage, or as a convenient way to write conditional logic.
always @(posedge clk) // Execute the next statement on every rising clock edge.
count <= count+1;
Procedural code is written like c code and assumes every assignment is stored in memory until over written. For synthesis, with flip-flop storage, this type of thinking generates too much storage. However people prefer procedural
code because it is usually much easier to write, for example, if and case statements are only allowed in procedural
code. As a result, the synthesizers have been constructed which can recognize certain styles of procedural code as
actually combinational. They generate a flip-flop only for left-hand variables which truly need to be stored. However
if you stray from this style, beware. Your synthesis will start to fill with superfluous latches.
This manual introduces the basic and most common Verilog behavioral and gate-level modelling constructs, as
well as Verilog compiler directives and system functions. Full description of the language can be found in Cadence
Verilog-XL Reference Manual and Synopsys HDL Compiler for Verilog Reference Manual. The latter emphasizes
only those Verilog constructs that are supported for synthesis by the Synopsys Design Compiler synthesis tool.
In all examples, Verilog keyword are shown in boldface. Comments are shown in italics.
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2. Lexical Tokens
Verilog source text files consists of the following lexical tokens:

2.1. White Space

White spaces separate words and can contain spaces, tabs, new-lines and form feeds. Thus a statement can extend
over multiple lines without special continuation characters.

2.2. Comments

Comments can be specified in two ways (exactly the same way as in C/C++):
Begin the comment with double slashes (//). All text between these characters and the end of the line will be
ignored by the Verilog compiler.
Enclose comments between the characters /* and */. Using this method allows you to continue comments on
more than one line. This is good for “commenting out” many lines code, or for very brief in-line comments.

2.3. Numbers

Number storage is defined as a number of bits, but values can be specified in binary, octal, decimal or hexadecimal
(See Sect. 6.1. for details on number notation).
Examples are 3’b001, a 3-bit number, 5’d30, (=5’b11110), and 16‘h5ED4, (=16’d24276)

2.4. Identifiers

Identifiers are user-defined words for variables, function names, module names, block names and instance names.
Identifiers begin with a letter or underscore (Not with a number or $) and can include any number of letters, digits and
underscores. Identifiers in Verilog are case-sensitive.
Syntax
allowed symbols
ABCDE . . . abcdef. . . 1234567890 _$
not allowed: anything else especially
- &#@

by_8_shifter
_ABC_
Read_

_abc_

2.5. Operators

Operators are one, two and sometimes three characters used to perform operations on variables.
Examples include >, +, ~, &, !=. Operators are described in detail in “Operators” on p. 6.

2.6. Verilog Keywords

These are words that have special meaning in Verilog. Some examples are assign, case, while, wire, reg, and, or,
nand, and module. They should not be used as identifiers. Refer to Cadence Verilog-XL Reference Manual for a
complete listing of Verilog keywords. A number of them will be introduced in this manual. Verilog keywords also
includes Compiler Directives (Sect. 15. ) and System Tasks and Functions (Sect. 16. ).
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3. Gate-Level Modelling
Primitive logic gates are part of the Verilog language. Two properties can be specified, drive_strength and delay.
Drive_strength specifies the strength at the gate outputs. The strongest output is a direct connection to a source, next
comes a connection through a conducting transistor, then a resistive pull-up/down. The drive strength is usually not
specified, in which case the strengths defaults to strong1 and strong0. Refer to Cadence Verilog-XL Reference Manual for more details on strengths.
Delays: If no delay is specified, then the gate has no propagation delay; if two delays are specified, the first represent
the rise delay, the second the fall delay; if only one delay is specified, then rise and fall are equal. Delays are ignored
in synthesis. This method of specifying delay is a special case of “Parameterized Modules” on page 11. The parameters for the primitive gates have been predefined as delays.

3.1. Basic Gates

These implement the basic logic gates. They have one output and one or more inputs. In the gate instantiation syntax
shown below, GATE stands for one of the keywords and, nand, or, nor, xor, xnor.
Syntax
GATE (drive_strength) # (delays)
instance_name1(output, input_1,
input_2,..., input_N),
instance_name2(outp,in1, in2,..., inN);
Delays is
#(rise, fall) or
# rise_and_fall or
#(rise_and_fall)

3.2. buf, not Gates

These implement buffers and inverters, respectively. They have one input and one or more outputs. In the gate instantiation syntax shown below, GATE stands for either the keyword buf or not
Syntax
GATE (drive_strength) # (delays)
instance_name1(output_1, output_2,
..., output_n, input),
instance_name2(out1, out2, ..., outN, in);

3.3. Three-State Gates; bufif1, bufif0, notif1, notif0

These implement 3-state buffers and inverters. They propagate z (3-state or high-impedance) if their control signal is
deasserted. These can have three delay specifications: a rise time, a fall time, and a time to go into 3-state.
A

bufif0
BUS = Z

notif0

CTRL=1

bufif1
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4. Data Types
4.1. Value Set

Verilog consists of only four basic values. Almost all Verilog data types store all these values:
0 (logic zero, or false condition)
1 (logic one, or true condition)
x (unknown logic value)
x and z have limited use for synthesis.
z (high impedance state)

4.2. Wire

A wire represents a physical wire in a circuit and is used to connect gates or modules. The value of a wire can be
read, but not assigned to, in a function or block. See “Functions” on p. 19, and “Procedures: Always and Initial
Blocks” on p. 18. A wire does not store its value but must be driven by a continuous assignment statement or by connecting it to the output of a gate or module. Other specific types of wires include:
wand (wired-AND);:the value of a wand depend on logical AND of all the drivers connected to it.
wor (wired-OR);: the value of a wor depend on logical OR of all the drivers connected to it.
tri (three-state;): all drivers connected to a tri must be z, except one (which determines the value of the tri).
Syntax
wire [msb:lsb] wire_variable_list;
wand [msb:lsb] wand_variable_list;
wor [msb:lsb] wor_variable_list;
tri [msb:lsb] tri_variable_list;

4.3. Reg

A reg (register) is a data object that holds its value from one procedural assignment to the next. They are used only in
functions and procedural blocks. See “Wire” on p. 4 above. A reg is a Verilog variable type and does not necessarily
imply a physical register. In multi-bit registers, data is stored as unsigned numbers and no sign extension is done for
what the user might have thought were two’s complement numbers.
Syntax
reg [msb:lsb] reg_variable_list;

4.4. Input, Output, Inout

These keywords declare input, output and bidirectional ports of a module or task. Input and inout ports are of type
wire. An output port can be configured to be of type wire, reg, wand, wor or tri. The default is wire.
Syntax
input [msb:lsb] input_port_list;
output [msb:lsb] output_port_list;
inout [msb:lsb] inout_port_list;
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4.5. Integer

Integers are general-purpose variables. For synthesois they are used mainly loops-indicies, parameters, and constants. See“Parameter” on p. 5. They are of implicitly of type reg. However they store data as signed numbers
whereas explicitly declared reg types store them as unsigned. If they hold numbers which are not defined at compile
time, their size will default to 32-bits. If they hold constants, the synthesizer adjusts them to the minimum width
needed at compilation.
Syntax
integer integer_variable_list;
... integer_constant ... ;

4.6. Supply0, Supply1

Supply0 and supply1 define wires tied to logic 0 (ground) and logic 1 (power), respectively.
Syntax
supply0 logic_0_wires;
supply1 logic_1_wires;

4.7. Time

Time is a 64-bit quantity that can be used in conjunction with the $time system task to hold simulation time. Time is
not supported for synthesis and hence is used only for simulation purposes.
Syntax
time time_variable_list;

4.8. Parameter

A parameter defines a constant that can be set when you instantiate a module. This allows customization of a module during instantiation. See also “Parameterized Modules” on page 11.
Syntax
parameter par_1 = value,
par_2 = value, .....;
parameter [range] parm_3 = value
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5. Operators
5.1. Arithmetic Operators

These perform arithmetic operations. The + and - can be used as either unary (-z) or binary (x-y) operators.
Operators
+ (addition)
(subtraction)
* (multiplication)
/
(division)
% (modulus)

5.2. Relational Operators

Relational operators compare two operands and return a single bit 1or 0. These operators synthesize into comparators.
Wire and reg variables are positive Thus (-3’b001) = = 3’b111 and (-3d001)>3d110. However for integers -1< 6.
Operators
<
<=
>
>=
==
!=

(less than)
(less than or equal to)
(greater than)
(greater than or equal to)
(equal to)
(not equal to)

else

else

5.3. Bit-wise Operators

Bit-wise operators do a bit-by-bit comparison between two operands. However see“Reduction Operators” on p. 7.
Operators

a

~
(bitwise NOT)
&
(bitwise AND)
|
(bitwise OR)
^
(bitwise XOR)
~^ or ^~(bitwise XNOR)

a(0

a(1)

2

5.4. Logical Operators

Logical operators return a single bit 1 or 0. They are the same as bit-wise operators only for single bit operands. They
can work on expressions, integers or groups of bits, and treat all values that are nonzero as “1”. Logical operators are
typically used in conditional (if ... else) statements since they work with expressions.
Operators
!
(logical NOT)
&& (logical AND)
|| (logical OR)
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5.5. Reduction Operators

Reduction operators operate on all the bits of an operand vector and return a single-bit value. These are the unary (one
argument) form of the bit-wise operators above.
Operators
a(0)

&
(reduction AND)
|
(reduction OR)
~&
(reduction NAND)
~|
(reduction NOR)
^
(reduction XOR)
~^ or ^~(reduction XNOR)

5.6. Shift Operators

Shift operators shift the first operand by the number of bits specified by the second operand. Vacated positions are
filled with zeros for both left and right shifts (There is no sign extension).
Operators
<< (shift left)
>> (shift right)

5.7. Concatenation Operator

The concatenation operator combines two or more operands to form a larger vector.
Operators

{ }(concatenation)

5.8. Replication Operator

The replication operator makes multiple copies of an item.
Operators

{n{item}} (n fold replication of an item)

For synthesis, Synopsis did not like a zero replication. For example:parameter n=5, m=5;
assign x= {(n-m){a}}
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5.9. Conditional Operator: “?”

Conditional operator is like those in C/C++. They evaluate one of the two expressions based on a condition. It will
synthesize to a multiplexer (MUX).
Operators
g

(cond) ? (result if cond true):
(result if cond false)

x
1

1

5.10. Operator Precedence

Table 6.1 shows the precedence of operators from highest to lowest. Operators on the same level evaluate from left to
right. It is strongly recommended to use parentheses to define order of precedence and improve the readability of
your code.
Operator

Name

[ ]

bit-select or part-select

( )

parenthesis

!, ~

logical and bit-wise NOT

&, |, ~&, ~|, ^, ~^, ^~

reduction AND, OR, NAND, NOR, XOR, XNOR;
If X=3’B101 and Y=3’B110, then X&Y=3’B100, X^Y=3’B011;

+, -

unary (sign) plus, minus; +17, -7

{ }

concatenation; {3’B101, 3’B110} = 6’B101110;

{{ }}

replication; {3{3'B110}} = 9'B110110110

*, /, %

multiply, divide, modulus; / and % not be supported for synthesis

+, -

binary add, subtract.

<<, >>

shift left, shift right; X<<2 is multiply by 4

<, <=, >, >=

comparisons. Reg and wire variables are taken as positive numbers.

= =, !=

logical equality, logical inequality

= = =, != =

case equality, case inequality; not synthesizable

&

bit-wise AND; AND together all the bits in a word

^, ~^, ^~

bit-wise XOR, bit-wise XNOR

|

bit-wise OR; AND together all the bits in a word

&&,

logical AND. Treat all variables as False (zero) or True (nonzero).
logical OR. (7||0) is (T||F) = 1, (2||-3) is (T||T) =1,
(3&&0) is (T&&F) = 0.

||
?:

conditional. x=(cond)? T : F;
Table 5.1: Verilog Operators Precedence
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6. Operands
6.1. Literals

Literals are constant-valued operands that can be used in Verilog expressions. The two common Verilog literals are:
(a) String: A string literal is a one-dimensional array of characters enclosed in double quotes (“ “).
(b) Numeric: constant numbers specified in binary, octal, decimal or hexadecimal.
Number Syntax
n’Fddd..., where
n - integer representing number of bits
F - one of four possible base formats:
b (binary), o (octal), d (decimal),
h (hexadecimal). Default is d.
dddd - legal digits for the base format

267

6.2. Wires, Regs, and Parameters

Wires, regs and parameters can also be used as operands in Verilog expressions. These data objects are described in
more detail in Sect. 4. .

6.3. Bit-Selects “x[3]” and Part-Selects “x[5:3]”

Bit-selects and part-selects are a selection of a single bit and a group of bits, respectively, from a wire, reg or parameter vector using square brackets “[ ]”. Bit-selects and part-selects can be used as operands in expressions in much the
same way that their parent data objects are used.
Syntax
variable_name[index]
variable_name[msb:lsb]

6.4. Function Calls

The return value of a function can be used directly in an expression without first assigning it to a register or wire variable. Simply place the function call as one of the operands. Make sure you know the bit width of the return value of
the function call. Construction of functions is described in “Functions” on page 19
Syntax
function_name (argument_list)
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7. Modules
7.1. Module Declaration

A module is the principal design entity in Verilog. The first line of a module declaration specifies the name and port
list (arguments). The next few lines specifies the i/o type (input, output or inout, see Sect. 4.4. ) and width of each
port. The default port width is 1 bit.
Then the port variables must be declared wire, wand,. . ., reg (See Sect. 4. ). The default is wire. Typically inputs are
wire since their data is latched outside the module. Outputs are type reg if their signals were stored inside an always
or initial block (See Sect. 10. ).
Syntax
module module_name (port_list);
input [msb:lsb] input_port_list;
output [msb:lsb] output_port_list;
inout [msb:lsb] inout_port_list;
... statements ...
endmodule

Example 7 .1
module add_sub(add, in1, in2, oot);
input add;
// defaults to wire
input [7:0] in1, in2; wire in1, in2;
output [7:0] oot; reg oot;
... statements ...
endmodule

add
in1

oot

8
in2

8

8

7.2. Continuous Assignment

The continuous assignment is used to assign a value onto a wire in a module. It is the normal assignment outside of
always or initial blocks (See Sect. 10. ). Continuous assignment is done with an explicit assign statement or by
assigning a value to a wire during its declaration. Note that continuous assignment statements are concurrent and are
continuously executed during simulation. The order of assign statements does not matter. Any change in any of the
right-hand-side inputs will immediately change a left-hand-side output.
Syntax
wire wire_variable = value;
assign wire_variable = expression;

c
y

b

7.3. Module Instantiations

Module declarations are templates from which one creates actual objects (instantiations). Modules are instantiated
inside other modules, and each instantiation creates a unique object from the template. The exception is the top-level
module which is its own instantiation.
The instantiated module’s ports must be matched to those defined in the template. This is specified:
(i) by name, using a dot(.) “ .template_port_name (name_of_wire_connected_to_port )”.
or(ii) by position, placing the ports in exactly the same positions in the port lists of both the template and the instance.
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Syntax for Instantiation
module_name
instance_name_1 (port_connection_list),
instance_name_2 (port_connection_list),
......
instance_name_n (port_connection_list);
endmodule

Modules may not be instantiated inside procedural blocks. See “Procedures: Always and Initial Blocks” on page 18.

7.4. Parameterized Modules

You can build modules that are parameterized and specify the value of the parameter at each instantiation of the module. See “Parameter” on page 5 for the use of parameters inside a module. Primitive gates have parameters which
have been predefined as delays. See “Basic Gates” on page 3.
Syntax
module_name #(parameter_values)
instance_name(port_connection_list);

shift_n

Synthesis does not support the defparam keyword which is an alternate way of changing parameters.
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c

8. Behavioral Modeling

Verilog has four levels of modelling:
1) The switch level which includes MOS transistors modelled as switches. This is not discussed here.
2) The gate level. See “Gate-Level Modelling” on p. 3
3) The Data-Flow level. See Example 7 .4 on page 11
4) The Behavioral or procedural level described below.
Verilog procedural statements are used to model a design at a higher level of abstraction than the other levels. They
provide powerful ways of doing complex designs. However small changes n coding methods can cause large changes
in the hardware generated. Procedural statements can only be used in procedures. Verilog procedures are described
later in “Procedures: Always and Initial Blocks” on page 18,“Functions” on page 19, and “Tasks Not Synthesizable”
on page 21.

8.1. Procedural Assignments

Procedural assignments are assignment statements used within Verilog procedures (always and initial blocks). Only
reg variables and integers (and their bit/part-selects and concatenations) can be placed left of the “=” in procedures.
The right hand side of the assignment is an expression which may use any of the operator types described in Sect. 5.

8.2. Delay in Assignment (not for synthesis)

In a delayed assignment t time units pass before the statement is executed and the left-hand assignment is made.
With intra-assignment delay, the right side is evaluated immediately but there is a delay of t before the result is
place in the left hand assignment. If another procedure changes a right-hand side signal during t, it does not effect
the output. Delays are not supported by synthesis tools.
Syntax for Procedural Assignment
Delayed assignment
#t variable = expression;
Intra-assignment delay
variable = #t expression;

8.3. Blocking Assignments

Procedural (blocking) assignments (=) are done sequentially in the order the statements are written. A second
assignment is not started until the preceding one is complete. See also Sect. 9.4.
Syntax
Blocking
variable = expression;
variable = #t expression;
grab inputs now, deliver ans.
later.
#t variable = expression;
grab inputs later, deliver ans.
later

X

C1

C1

x

y
C1
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8.4. Nonblocking (RTL) Assignments (see below for synthesis)

RTL (nonblocking) assignments (<=), which follow each other in the code, are done in parallel. The right hand
side of nonblocking assignments is evaluated starting from the completion of the last blocking assignment or if none,
the start of the procedure. The transfer to the left hand side is made according to the delays. A delay in a non-blocking
statement will not delay the start of any subsequent statement blocking or non-blocking.
A good habit is to use “<=” if the same variable appears on both sides of the equal sign (Example 0 .1 on page 13).

For synthesis
• One must not mix “<=” or “=” in the same procedure.
• “<=” best mimics what physical flip-flops do; use it for “always @ (posedge clk ..) type procedures.
• “=” best corresponds to what c/c++ code would do; use it for combinational procedures.
:
Syntax
Non-Blocking
variable <= expression;
variable <= #t expression;
#t variable <= expression;
X

Z

Y
C1

C1

x

z

y
C1

C1

The following example shows interactions between blocking and non-blocking for simulation. Do not mix the two
types in one procedure for synthesis.
Syntax
Non-Blocking
variable <= expression;
variable <= #t expression;
?#t variable <=expression;
Blocking
variable = expression;
variable = #t expression;
#t variable = expression;

8.5. begin ... end

begin ... end block statements are used to group several statements for use where one statement is syntactically
allowed. Such places include functions, always and initial blocks, if, case and for statements. Blocks can optionally
be named. See “disable” on page 15) and can include register, integer and parameter declarations.
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Syntax
begin : block_name
reg [msb:lsb] reg_variable_list;
integer [msb:lsb] integer_list;
parameter [msb:lsb] parameter_list;
... statements ...
end

8.6. for Loops

Similar to for loops in C/C++, they are used to repeatedly execute a statement or block of statements. If the loop contains only one statement, the begin ... end statements may be omitted.
Syntax
for (count = value1;
count </<=/>/>= value2;
count = count +/- step)
begin
... statements ...
end

8.7. while Loops

The while loop repeatedly executes a statement or block of statements until the expression in the while statement
evaluates to false. To avoid combinational feedback during synthesis, a while loop must be broken with an
@(posedge/negedge clock) statement (Section 9.2). For simulation a delay inside the loop will suffice. If the loop
contains only one statement, the begin ... end statements may be omitted.
Syntax
while (expression)
begin
... statements ...
end

8.8. forever Loops

The forever statement executes an infinite loop of a statement or block of statements. To avoid combinational feedback during synthesis, a forever loop must be broken with an @(posedge/negedge clock) statement (Section 9.2). For
simulation a delay inside the loop will suffice. If the loop contains only one statement, the begin ... end statements
may be omitted. It is
Syntax
forever
begin
... statements ...

8.9. repeat Not synthesizable

The repeat statement executes a statement or block of statements a fixed number of times.
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Syntax
repeat (number_of_times)
begin
... statements ...
end

8.10. disable

Execution of a disable statement terminates a block and passes control to the next statement after the block. It is like
the C break statement except it can terminate any loop, not just the one in which it appears.
Disable statements can only be used with named blocks.
Syntax
disable block_name;
forever

end

8.11. if ... else if ... else

The if ... else if ... else statements execute a statement or block of statements depending on the result of the expression
following the if. If the conditional expressions in all the if’s evaluate to false, then the statements in the else block, if
present, are executed.
There can be as many else if statements as required, but only one if block and one else block. If there is one statement
in a block, then the begin .. end statements may be omitted.
Both the else if and else statements are optional. However if all possibilities are not specifically covered, synthesis
will generated extra latches.
Syntax
if (expression)
begin
... statements ...
end
else if (expression)
begin
... statements ...
end
... more else if blocks ...
else
begin
... statements ...
end
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8.12. case

The case statement allows a multipath branch based on comparing the expression with a list of case choices.
Statements in the default block executes when none of the case choice comparisons are true (similar to the else block
in the if ... else if ... else). If no comparisons , including delault, are true, synthesizers will generate unwanted latches.
Good practice says to make a habit of puting in a default whether you need it or not.
If the defaults are dont cares, define them as ‘x’ and the logic minimizer will treat them as don’t cares.
Case choices may be a simple constant or expression, or a comma-separated list of same.
Syntax
case (expression)
case_choice1:
begin
... statements ...
end
case_choice2:
begin
... statements ...
end
... more case choices blocks ...
default:
begin
... statements ...
end
endcase

endcase

8.13. casex

In casex(a) the case choices constant “a” may contain z, x or ? which are used as don’t cares for comparison. With
case the corresponding simulation variable would have to match a tri-state, unknown, or either signal. In short, case
uses x to compare with an unknown signal. Casex uses x as a don’t care which can be used to minimize logic.
Syntax
same as for case statement
(Section 8.10)

8.14. casez

Casez is the same as casex except only ? and z (not x) are used in the case choice constants as don’t cares. Casez is
favored over casex since in simulation, an inadvertent x signal, will not be matched by a 0 or 1 in the case choice.
Syntax
same as for case statement
(Section 8.10)
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9. Timing Controls
9.1. Delay Control Not synthesizable

This specifies the delay time units before a statement is executed during simulation. A delay time of zero can also be
specified to force the statement to the end of the list of statements to be evaluated at the current simulation time.
Syntax
#delay statement;

9.2. Event Control, @

This causes a statement or begin-end block to be executed only after specified events occur. An event is a change in
a variable. and the change may be: a positive edge, a negative edge, or either (a level change), and is specified by the
keyword posedge, negedge, or no keyword respectively. Several events can be combined with the or keyword. Event
specification begins with the character @and are usually used in always statements. See page 18.
For synthesis one cannot combine level and edge changes in the same list.
For flip-flop and register synthesis the standard list contains only a clock and an optional reset.
For synthesis to give combinational logic, the list must specify only level changes and must contain all the variables
appearing in the right-hand-side of statements in the block.
Syntax
@ (posedge variable or
negedge variable) statement;

9.3. Wait Statement Not synthesizable

The wait statement makes the simulator wait to execute the statement(s) following the wait until the specified condition evaluates to true. Not supported for synthesis.
Syntax
wait (condition_expression) statement;

9.4. Intra-Assignment Delay Not synthesizable

This delay #is placed after the equal sign. The left-hand assignment is delayed by the specified time units, but the
right-hand side of the assignment is evaluated before the delay instead of after the delay. This is important when a
variable may be changed in a concurrent procedure. See also “Delay in Assignment (not for synthesis)” on page 12.
Syntax
variable = #t expression;
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10. Procedures: Always and Initial Blocks
10.1. Always Block

The always block is the primary construct in RTL modeling. Like the continuous assignment, it is a concurrent
statement that is continuously executed during simulation. This also means that all always blocks in a module execute
simultaneously. This is very unlike conventional programming languages, in which all statements execute sequentially. The always block can be used to imply latches, flip-flops or combinational logic. If the statements in the
always block are enclosed within begin ... end, the statements are executed sequentially. If enclosed within the fork
... join, they are executed concurrently (simulation only).
The always block is triggered to execute by the level, positive edge or negative edge of one or more signals (separate signals by the keyword or). A double-edge trigger is implied if you include a signal in the event list of the always
statement. The single edge-triggers are specified by posedge and negedge keywords.
Procedures can be named. In simulation one can disable named blocks. For synthesis it is mainly used as a comment.
Syntax 1
always @(event_1 or event_2 or ...)
begin
... statements ...
end
Syntax 2
always @(event_1 or event_2 or ...)
begin: name_for_block
... statements ...
end

10.2. Initial Block

The initial block is like the always block except that it is executed only once at the beginning of the simulation. It is
typically used to initialize variables and specify signal waveforms during simulation. Initial blocks are not supported
for synthesis.
Syntax
initial
begin
... statements ...
end
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11. Functions
Functions are declared within a module, and can be called from continuous assignments, always blocks or other functions. In a continuous assignment, they are evaluated when any of its declared inputs change. In a procedure, they are
evaluated when invoked.
Functions describe combinational logic, and by do not generate latches. Thus an if without an else will simulate as
though it had a latch but synthesize without one. This is a particularly bad case of synthesis not following the simulation. It is a good idea to code functions so they would not generate latches if the code were used in a procedure.
Functions are a good way to reuse procedural code, since modules cannot be invoked from a procedure.

11.1. Function Declaration

A function declaration specifies the name of the function, the width of the function return value, the function input
arguments, the variables (reg) used within the function, and the function local parameters and integers.
Syntax, Function Declaration
function [msb:lsb] function_name;
input [msb:lsb] input_arguments;
reg [msb:lsb] reg_variable_list;
parameter [msb:lsb] parameter_list;
integer [msb:lsb] integer_list;
... statements ...
endfunction

11.2. Function Return Value

When you declare a function, a variable is also implicitly declared with the same name as the function name, and with
the width specified for the function name (The default width is 1-bit). This variable is “my_func” in Example 11 .1 on
page 19. At least one statement in the function must assign the function return value to this variable.

11.3. Function Call

As mentioned in Sect. 6.4. , a function call is an operand in an expression. A function call must specify in its terminal
list all the input parameters.

11.4. Function Rules

The following are some of the general rules for functions:
- Functions must contain at least one input argument.
- Functions cannot contain an inout or output declaration.
- Functions cannot contain time controlled statements (#, @, wait).
- Functions cannot enable tasks.
- Functions must contain a statement that assigns the return value to the implicit function name register.
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11.5. Function Example

A Function has only one output. If more than one return value is required, the outputs should be concatenated into
one vector before assigning it to the function name. The calling module program can then extract (unbundle) the individual outputs from the concatenated form. Example 11.2 shows how this is done, and also illustrates the general use
and syntax of functions in Verilog modeling.
Syntax
function_name = expression

Example 11 .2
module simple_processor (instruction, outp);
input [31:0] instruction;
output [7:0] outp;
reg [7:0] outp;; // so it can be assigned in always block
reg func;
reg [7:0] opr1, opr2;
function [16:0] decode_add (instr) // returns 1 1-bit plus 2 8-bits
input [31:0] instr;
reg add_func;
reg [7:0] opcode, opr1, opr2;
begin
opcode = instr[31:24];
opr1 = instr[7:0];
case (opcode)
8’b10001000: begin
// add two operands
add_func = 1;
opr2 = instr[15:8];
end
8’b10001001: begin
// subtract two operands
add_func = 0;
opr2 = instr[15:8];
end
8’b10001010: begin
// increment operand
add_func = 1;
opr2 = 8’b00000001;
end
default: begin;
// decrement operand
add_func = 0;
opr2 = 8’b00000001;
end
endcase
decode_add = {add_func, opr2, opr1}; // concatenated into 17-bits
end
endfunction
// ------------------------------------------------------------------------always @(instruction) begin
{func, op2, op1} = decode_add (instruction); // outputs unbundled
if (func == 1)
outp = op1 + op2;
else
outp = op1 - op2;
end
endmodule
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12. Tasks Not Synthesizable
A task is similar to a function, but unlike a function it has both input and output ports. Therefore tasks do not return
values. Tasks are similar to procedures in most programming languages. The syntax and statements allowed in tasks
are those specified for functions (Sections 11).

Syntax
task task_name;
input [msb:lsb] input_port_list;
output [msb:lsb] output_port_list;
reg [msb:lsb] reg_variable_list;
parameter [msb:lsb] parameter_list;
integer [msb:lsb] integer_list;
... statements ...
endtask

endtask

endmodule
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13. Component Inference
13.1. Latches

A latch is inferred (put into the synthesized circuit) if a variable is not assigned to in the else branch of an if ... else if
... else statement. A latch is also inferred in a case statement if a variable is assigned to in only some of the possible
case choice branches. Assigning a variable in the default branch avoids the latch. In general, a latch is inferred in if ...
else if ... else and case statements if a variable, or one of its bits, is only assigned to in only some of the possible
branches.
To improve code readability, use the if statement to synthesize a latch because it is difficult to explicitly specify the
latch enable signal when using the case statement.
Syntax
See Sections 8.9 and 8.10 for
if ... else if ... else and case statements

i
o
c

13.1. Edge-Triggered Registers, Flip-flops, Counters

A register (flip-flop) is inferred by using posedge or negedge clause for the clock in the event list of an always block.
To add an asynchronous reset, include a second posedge/negedge for the reset and use the if (reset) ... else statement.
Note that when you use the negedge for the reset (active low reset), the if condition is (!reset).
Syntax
always @(posedge clk or
posedge reset_1 or
negedge reset_2)
begin
if (reset_1) begin
... reset assignments
end
else if (!reset_2) begin
... reset assignments
end
else
begin
...register assignments
end
end

c

a
clk

CLK

rst
b

else

a
clk

CLK

end;
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13.2. Multiplexers

A multiplexer is inferred by assigning a variable to different variables/values in each branch of an if or case statement. You can avoid specifying each and every possible branch by using the else and default branches. Note that a
latch will be inferred if a variable is not assigned to for all the possible branch conditions.
To improve readability of your code, use the case statement to model large multiplexers.
Syntax
sel

See Sections 8.9 and 8.10 for
if ... else if ... else and case statements

a
y

sel[1:0]

y
d

13.3. Adders/Subtracters

The +/- operators infer an adder/subtracter whose width depend on the width of the larger operand.
Syntax
See Section 7 for operators
y

13.4. Tri-State Buffers

A tristate buffer is inferred if a variable is conditionally assigned a value of z using an if, case or conditional operator.
Syntax
See Sections 8.9 and 8.10 for
if ... else if ... else and case statements

en
a

y

13.5. Other Component Inferences

Most logic gates are inferred by the use of their corresponding operators. Alternatively a gate or component may be
explicitly instantiated by using the primitive gates (and, or, nor, inv ...) provided in the Verilog language.
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14. Finite State Machines.

For synthesis

When modeling finite state machines, it is recommended to separate the sequential current-state logic from the combinational next-state and output logic.
State Diagram

Example 14 .1

for lack of space the outputs are not
shown on the state diagram, but are:
in state0: Zot = 000,
in state1: Zot = 101,
in state2: Zot = 111,
in state3: Zot = 001.

start=0
reset=1
state0
start=1

wait3=0

module my_fsm (clk, rst, start, skip3, wait3, Zot);
input clk, rst, start, skip3, wait3;
output [2:0] Zot; // Zot is declared reg so that it can
reg [2:0] Zot;
// be assigned in an always block.
parameter state0=0, state1=1, state2=2, state3=3;
reg [1:0] state, nxt_st;
always @ (state or start or skip3 or wait3)
begin : next_state_logic //Name of always procedure.
case (state)
state0: begin
if (start) nxt_st = state1;
else nxt_st = state0;
end
state1: begin

state3

skip3=1

state1

wait3=1

state2: begin

skip3=0
state2

Using Macros for state definition
As an alternative forparameter state0=0, state1=1,
state2=2, state3=3;
one can use macros. For example after the
definition below 2'd0 will be textually
substituted whenever `state0 is used.
`define state0 2'd0
`define state1 2'd1
`define state2 2'd
`define state3 2'd3;
When using macro definitions one must
put a back quote in front. For example:
case (state)
`state0: Zot = 3’b000;
`state1: Zot = 3’b101;
`state2: Zot = 3’b111;
`state3: Zot = 3’b001;
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state3: begin

nxt_st = state2;
end
if (skip3) nxt_st = state0;
else nxt_st = state3;
end

if (wait3) nxt_st = state3;
else nxt_st = state0;
end
default: nxt_st = state0;
endcase
// default is optional since all 4 cases are
end
// covered specifically. Good practice says uses it.
always @(posedge clk or posedge rst)
begin : register_generation
if (rst) state = state0;
else state = nxt_st;
end
always @(state) begin : output_logic
case (state)
state0: Zot = 3’b000;
state1: Zot = 3’b101;
state2: Zot = 3’b111;
state3: Zot = 3’b001;
default: Zot = 3’b000;// default avoids latches
endcase
end
endmodule
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14.1.

14.2. Counters

Counters are a simple type of finite-state machine where separation of the flip-flop generation code and the next-state
generation code is not worth the effort. In such code, use the nonblocking “<=” assignment operator.
Binary Counter
Using toggle flip-flops

C1

C1

C1

C1

count[3] count[2]
count[1]

14.3. Shift Registers

Shift registers are also best done completely in the flip-flop generation code. Use the nonblocking “<=” assignment
operator so the operators “<< N” shifts left N bits. The operator “>>N” shifts right N bits. See also Example 8 .3 on
page 13.
Shift Register

1D

1D

C1

1D

C1

1D

C1

C1

else

Linear-Feedback Shift Register
Q[2]

1D
C1

C1

1D
C1

else
end
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15. Compiler Directives
Compiler directives are special commands, beginning with ‘, that affect the operation of the Verilog simulator. The
Synopsys Verilog HDL Compiler/Design Compiler and many other synthesis tools parse and ignore compiler directives, and hence can be included even in synthesizable models. Refer to Cadence Verilog-XL Reference Manual for a
complete listing of these directives. A few are briefly described here.

15.1. Time Scale

`timescale specifies the time unit and time precision. A time unit of 10 ns means a time expressed as say #2.3 will
have a delay of 23.0 ns. Time precision specifies how delay values are to be rounded off during simulation. Valid
time units include s, ms, s, ns, ps, fs.
Only 1, 10 or 100 are valid integers for specifying time units or precision. It also determines the displayed time units
in display commands like $display
Syntax
`timescale time_unit / time_precision;

15.2. Macro Definitions

A macro is an identifier that represents a string of text. Macros are defined with the directive `define, and are invoked
with the quoted macro name as shown in the example.
Syntax
`define macro_name text_string;
. . . `macro_name . . .

15.3. Include Directive

Include is used to include the contents of a text file at the point in the current file where the include directive is. The
include directive is similar to the C/C++ include directive.
Syntax
`include file_name;
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16. System Tasks and Functions
These are tasks and functions that are used to generate input and output during simulation. Their names begin with a
dollar sign ($). The Synopsys Verilog HDL Compiler/Design Compiler and many other synthesis tools parse and
ignore system functions, and hence can be included even in synthesizable models. Refer to Cadence Verilog-XL Reference Manual for a complete listing of system functions. A few are briefly described here.
System tasks that extract data, like $monitor need to be in an initial or always block.

16.1. $display, $strobe, $monitor

These commands have the same syntax, and display their values as text on the screen during simulation. They are
much less convenient than waveform display tools like cwavesor Signalscan. $display and $strobe display once
every time they are executed, whereas $monitor displays every time one of its parameters changes. The difference
between $display and $strobe is that $strobe displays the parameters at the very end of the current simulation time
unit. The format string is like that in C/C++, and may contain format characters. Format characters include %d (decimal), %h (hexadecimal), %b (binary), %c (character), %s (string) and %t (time). Append b, h, o to the task name to
change default format to binary, octal or hexadecimal.
Syntax
$display (“format_string”,
par_1, par_2, ... );

16.2. $time, $stime, $realtime

These return the current simulation time as a 64-bit integer, a 32-bit integer, and a real number, respectively. Their
use is illustrated in Examples 4.6 and 13.1.

16.3. $reset, $stop, $finish

$reset resets the simulation back to time 0; $stop halts the simulator and puts it in the interactive mode where the
user can enter commands; $finish exits the simulator back to the operating system.

16.4. $deposit

$deposit sets a net to a particular value.
Syntax
$deposit (net_name, value);

16.5. $scope, $showscope

$scope(hierarchy_name) sets the current hierarchical scope to hierarchy_name. $showscopes(n) lists all modules,
tasks and block names in (and below, if n is set to 1) the current scope.

16.6. $list

$list (hierarchical_name) lists line-numbered source code of the named module, task, function or named-block.
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16.7. $random

$random generates a random integer every time it is called. If the sequence is to be repeatable, the first time one
invokes random give it a numerical argument (a seed). Otherwise the seed is derived from the computer clock.
Syntax
xzz = $random[(integer)];

16.8. $dumpfile, $dumpvar, $dumpon, $dumpoff, $dumpall

These can dump variable changes to a simulation viewer like cwaves. The dump files are capable of dumping all the
variables in a simulation. This is convenient for debugging, but can be very slow.
Syntax
$dumpfile(“filename.dmp”)
$dumpvar dumps all variables in the
design.
$dumpvar(1, top) dumps all the variables in module top and below, but not
modules instantiated in top.
$dumpvar(2, top) dumps all the variables in module top and 1 level below.
$dumpvar(n, top) dumps all the variables in module top and n-1 levels below.
$dumpvar(0, top) dumps all the variables in module top and all level below.
$dumpon initiates the dump.
$dumpoff stop dumping.

16.9. $shm_probe, $shm_open

These are special commands for the Simulation History Manager for Cadence cwavesonly. They will save variable
changes for later display.
Syntax
$shm_open (“cwave_dump.dm”)
$shm_probe (var1,var2, var3);
/* Dump all changes in the above 3 variables. */
$shm_probe(a, b, inst1.var1, inst1.var2);
/* Use the qualifier inst1. to look inside
the hierarchy. Here inside module
instance “inst1” the variables var1 and
var2 will be dumped.*/
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17. Test Benches
A test bench supplies the signals and dumps the outputs to simulate a Verilog design (module(s)). It invokes the
design under test, generates the simulation input vectors, and implements the system tasks to view/format the results
of the simulation. It is never synthesized so it can use all Verilog commands.
To view the waveforms when using Cadence Verilog XL Simulator, use the Cadence-specific Simulation History
Manager (SHM) tasks of $shm_open to open the file to store the waveforms, and $shm_probe to specify the variables to be included in the waveforms list. You can then use the Cadence cwaves waveform viewer by typing cwaves
& at the UNIX prompt.
Syntax
$shm_open(filename);
$shm_probe(var1, var2, ...)

Note also

var=$random
wait(condition) statement

Example 17 .1
‘timescale 1 ns /100 ps // time unit = 1ns; precision = 1/10 ns;
module my_fsm_tb; // Test Bench of FSM Design of Example 14.1
/* ports of the design under test are variables in the test bench */
reg clk, rst, start, skip3, wait3;
wire Button;
/**** DESIGN TO SIMULATE (my_fsm) INSTANTIATION ****/
my_fsm dut1 (clk, rst, start, skip3, wait3, Button);
/**** SECTION TO DISPLAY VARIABLES ****/
initial begin
$shm_open(“sim.db”);
//Open the SHM database file
/* Specify the variables to be included in the waveforms to be
viewed by Cadence cwaves */
$shm_probe(clk, reset, start);
// Use the qualifier dut1. to look at variables inside the instance dut1.
$shm_probe(skip3, wait3, Button, dut1.state, dut1.nxt_st);
end
/**** RESET AND CLOCK SECTION ****/
initial begin
clk = 0; rst=0;
#1 rst = 1; // The delay gives rst a posedge for sure.
#200 rst = 0; // Deactivate reset after two clock cycles +1 ns*/
end
always #50 clk = ~clk; // 10 MHz clock (50*1 ns*2) with 50% duty-cycle
/**** SPECIFY THE INPUT WAVEFORMS skip3 & wait3 ****/
initial begin
skip3 = 0; wait3 = 0; // at time 0, wait3=0, skip3=0
#1;
// Delay to keep inputs from changing on clock edge.
#600 skip3 = 1; // at time 601, wait3=0, skip3=1
#400 wait3 = 1; // at time 1001, wait3=1, skip3=0
skip3= 0;
#400 skip3 = 1; // at time 1401, wait3=1, skip3=1
wait(Button) skip3 = 0; // Wait until Button=1, then make skip3 zero.
wait3 = $random; //Generate a random number, transfer lsb into wait3
$finish;
// stop simulation. Without this it will not stop.
end
endmodule
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17.1. Synchronous Test Bench

In synchronous designs, one changes the data during certain clock cycles. In the previous test bench one had to keep
counting delays to be sure the data came in the right cycle. With a synchronous test bench the input data is stored in a
vector or array and one part injected in each clock cycle. The Verilog array is not defined in these notes.
Synchronous test benches are essential for cycle based simulators which do not use any delays smaller than a clock
cycle.
Things to note:
data[8:1]=8'b1010_1101;
The underscore visually separates the
bits. It acts like a comment.
if (I==9) $finish;
When the data is used up, finish
x<=data[I]; I<=I+1;
When synthesizing to flip-flops as in an
In an @(posedge... procedure,
always use nonblocking. Without that
you will be racing with the flip-flops in
the other modules.

#1;
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REFERENCE MANUALS

The Digilent Basys Board Reference Manual is available at
http://www.digilentinc.com/data/products/basys/basys_e_rm.pdf
The Digilent Basys3 Board Reference Manual is available at
http://www.digilentinc.com/Data/Products/BASYS2/Basys3_rm.pdf

